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Quick Start



Important User Information
Solid state equipment has operational characteristics differing from those of electromechanical equipment. Safety Guidelines 
for the Application, Installation and Maintenance of Solid State Controls (publication SGI-1.1 available from your local Rockwell 
Automation sales office or online at http://www.rockwellautomation.com/literature/) describes some important differences 
between solid state equipment and hard-wired electromechanical devices. Because of this difference, and also because of the 
wide variety of uses for solid state equipment, all persons responsible for applying this equipment must satisfy themselves that 
each intended application of this equipment is acceptable.

In no event will Rockwell Automation, Inc. be responsible or liable for indirect or consequential damages resulting from the use 
or application of this equipment.

The examples and diagrams in this manual are included solely for illustrative purposes. Because of the many variables and 
requirements associated with any particular installation, Rockwell Automation, Inc. cannot assume responsibility or liability for 
actual use based on the examples and diagrams.

No patent liability is assumed by Rockwell Automation, Inc. with respect to use of information, circuits, equipment, or software 
described in this manual.

Reproduction of the contents of this manual, in whole or in part, without written permission of Rockwell Automation, Inc., is 
prohibited.

Throughout this manual, when necessary, we use notes to make you aware of safety considerations.

Allen-Bradley, Rockwell Automation, Rockwell Software, CompactLogix, ControlNet, EtherNet/IP, DeviceNet, PowerFlex 40, PowerFlex 70, POINT I/O, RSLinx, PanelView Plus, RSNetWorx for DeviceNet, RSLogix 
5000, RSView Studio, and TechConnect are trademarks of Rockwell Automation, Inc.

Trademarks not belonging to Rockwell Automation are property of their respective companies.

WARNING
Identifies information about practices or circumstances that can cause an explosion in a hazardous environment, 
which may lead to personal injury or death, property damage, or economic loss.

IMPORTANT Identifies information that is critical for successful application and understanding of the product.

ATTENTION
Identifies information about practices or circumstances that can lead to personal injury or death, property damage, 
or economic loss. Attentions help you identify a hazard, avoid a hazard, and recognize the consequence

SHOCK HAZARD
Labels may be on or inside the equipment, for example, a drive or motor, to alert people that dangerous voltage may 
be present.

BURN HAZARD
Labels may be on or inside the equipment, for example, a drive or motor, to alert people that surfaces may reach 
dangerous temperatures.

http://literature.rockwellautomation.com/idc/groups/literature/documents/in/sgi-in001_-en-p.pdf
http://www.rockwellautomation.com/literature/


Where to Start

Follow the path that matches your hardware and network configuration.
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Where to Start
How Hardware is Connected

This quick start demonstrates the following possible control systems. Choose your hardware 
and networks, then follow the matching examples.

Option 1: 1769-L32E, 1769-L35E Control System

PanelView Plus terminal 
with built-in EtherNet/IP

Ethernet 
Switch

1769-L32E or 1769-L35E 
with Optional 1769-SDN for the 

DeviceNet Network

Serial (CP3 Cable)

PowerFlex 70 Drive 
with 20-COMM-E

PowerFlex 40 Drive 
with 22-COMM-E

PanelView Plus Terminal 
with Built-in EtherNet/IP 

Port

Computer with 
Standard Ethernet Port

Distributed 
POINT I/O 

Modules with 
1734-AENT
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Where to Start
Option 2: 1769-L32C, 1769-L35CR Control System

Option 3: 1769-L31 Control System

ControlNet Network 
with Taps

1769-L32C or 1769-L35CR 
with Optional 1769-SDN for the DeviceNet 

Network

PowerFlex 70 Drive 
with 20-COMM-C

PowerFlex 40 Drive 
with 22-COMM-C

PanelView Plus Terminal with 
ControlNet Communication Adapter

Computer with 
1784-PCIC, -PCICS 

ControlNet 
Communication Card

Distributed 1734 
POINT I/O Modules 

with 1734-ACNR

Serial (CP3 Cable)

To Optional 
DeviceNet 
Network

1769-L31 with 1769-SDN

1756-CP3 Serial Cable to 
CH0 on 1769-L31

DeviceNet Network with 
KwikLink 

Flat Cable and Micro Connectors

PowerFlex 70 
Drive with 

20-COMM-D

PowerFlex 40 
Drive with 

22-COMM-D

PanelView Plus Terminal with 
2706-NC13 Serial Cable to 

CH1 on 1769-L31 Distributed 1734 
POINT I/O 

Modules with 
1734-ADN

DeviceNet 
Power Supply 

1606-XLDNET8
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Where to Start
Notes:
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Preface

About This Publication This quick start provides examples and procedures for the use of a 
CompactLogix system. This publication includes version 18 release updates 
for RSLogix 5000 programming software. The procedures cover many of the 
most common user tasks, such as:

• connecting the controller to multiple devices (local and distributed I/O, 
drives, and a PanelView Plus terminal).

• connecting and configuring networks (EtherNet/IP, ControlNet, 
DeviceNet, and serial) for use with CompactLogix systems.

• creating and monitoring controller programs.

The examples are designed to get devices installed and communicating with 
each other in the simplest way possible. The programming examples are not 
complex, and offer easy solutions to verify that devices are functioning and 
communicating properly.

The beginning of each chapter contains the following information. Read these 
sections carefully before beginning work in each chapter.

• Before You Begin - This section lists the steps that must be completed 
and decisions that must be made before starting the chapter. Because 
the chapters in this quick start do not have to be completed in the order 
in which they appear, this section defines the minimum amount of 
preparation required before completing the current chapter.

• What You Need - This section lists the tools that are required to 
complete the steps in the current chapter. This includes, but is not 
limited to, hardware and software.

• Follow These Steps - This illustrates the steps in the current chapter 
and identifies which steps are required to complete the examples by 
using specific networks.

The electronic version of this publication contains links to pages within the 
publication for easier navigation. Click on any chapter title, chapter number, 
topic title, or page number to follow a link to the item. 

Additionally, resources available on the Web and listed in the Additional 
Resources tables function as hyperlinks within this electronic publication.
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Required Software To complete examples in this quick start, you need one of the following 
software packages.

If you do not use the RSLogix 5000 programming software packages 
recommended, you may need to purchase additional software to complete the 
examples in this quick start.

You will need to install the following software, included with the RSLogix 
5000 programming software packages listed:

• BootP-DHCP server

• ControlFlash software

• DeviceNet Tag Generator

• RSLinx software, version 2.54 or later

• RSLogix 5000 programming software, version 17 or later

• RSNetWorx software (version specific to your network option)

If you plan to complete the PanelView Plus examples within this quick start, 
you will also need FactoryTalkView Machine Edition software.

If using network Use RSLogix 5000 programming 
software edition

EtherNet/IP
(Options 1, 2, and 3)

•Full

•Standard

•Professional

ControlNet
(Option 2)

•Standard

•Professional 

DeviceNet
(Option 3)

•Standard

•Professional
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Parts List This table lists the hardware used in this quick start. The hardware you need 
depends on the options and examples you choose to complete. Specific 
hardware requirements are listed at the beginning of each chapter.

 Quantity Catalog Number Description

General Configuration

1 1769-IF4 Compact 4 Channel Analog Current/Voltage Input Module

1 1769-IQ16 Compact 16 Point 24V DC Sinking/Sourcing Input Module

1 1769-IF4XOF2 Compact 8 Bit Resolution, High Speed 4 In/2 Out Analog Combination Module

1 1769-OF2 Compact 2 Channel Analog Current/Voltage Output Module

1 1769-OB16(1) Compact 16 Point 24V DC Sourcing Output Module

1 1769-PA2 Compact Expansion Power Supply 120/240V AC Input 2 A @ 5V DC Output Module

1 1769-ECR Compact I/O Right End Cap/Terminator

1 1734-IB4(2) POINT I/O 4 Sink Input Module

1 1734-OB4E(2)(3) POINT I/O 4 Protected Output Module

1 1734-OE2C(2) POINT I/O 2 Current Output Analog Module

3 1734-TB Wiring Base w/ Removable IEC Screw Terminals

1 1794-PS13 FLEX I/O 85 - 264V AC to 24V DC 1.3 A Power Supply

1 22B-V2P3N104 PowerFlex 40 Drive

1 22B-CCB PowerFlex 40 Communication Adapter Cover

1 20AB4P2A3AYNNNNN PowerFlex 70 Drive

1 2711P-K10C4D1 PanelView Plus 10 inch Color Keypad Terminal with EtherNet/IP and RS-232 networks

1 1794-PS3 or 
2711P-RSACDIN

FLEX I/O DC Power Supply or general use AC Power Supply 

2 1756-CP3 RS-232 Cable

1 2706-NC13 PanelView Plus Serial Cable

2...3 N/A DIN Rail (steel not aluminum)

EtherNet/IP Configuration

1 1769-L32E CompactLogix EtherNet/IP Controller

1 1734-AENT POINT I/O EtherNet/IP Adapter

1 22-COMM-E EtherNet/IP Adapter for Use With the PowerFlex 40

1 20-COMM-E EtherNet/IP Adapter for Use With the PowerFlex 70

1 N/A 8-Port Ethernet Switch

6 N/A Ethernet Cables (straight through)
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ControlNet Configuration

1 1769-L32CR CompactLogix ControlNet Controller with Redundant Tap

1 1784-PCIC or 1784-PCICS ControlNet Communication Card for a Personal Computer

1 1734-ACNR POINT I/O ControlNet Adapter

1 22-COMM-C ControlNet Adapter for Use With the PowerFlex 40

1 20-COMM-C ControlNet Adapter for Use With the PowerFlex 70

1 2711P-RN15S PanelView Plus 1000 ControlNet Interface Module

6 1786-TPR ControlNet Tap

2 1786-XT ControlNet Terminating Resistor

5 1786-BNCP ControlNet BNC Coaxial Connector

Serial Configuration

1 1769-L31 1769-L31 CompactLogix Controller

1 1756-CP3 RS-232 cable

1 2706-NC13 Point-to-Point RS-232 Cable

DeviceNet Configuration

1 1769-SDN Compact I/O DeviceNet Scanner

1 1734-ADN POINT I/O DeviceNet Adapter

1 22-COMM-D DeviceNet Adapter for use with the PowerFlex 40

1 20-COMM-D DeviceNet Adapter for use with the PowerFlex 70

1 1606-XLDNET8 DeviceNet Power Supply

N/A 1485C-P1E75 KwikLink Flat Cable

2 1485A-T1E4 KwikLink Terminator/Resistor

4 1485P-P1E4-R5 KwikLink Sealed Micro Connector

4 1485K-P1F5-C KwikLink Right-angle Male to Cable

1 1485T-P1E4-B1 KwikLink Power Tap Module

(1) The 1769-OB16 module is the only Compact I/O module used in this quick start. The other modules are added as examples only and are not required.

(2) Use Point I/O modules at series C or later to complete examples in this quick start.
(3) The 1734-OB4E module is the only POINT I/O module used in this quick start. The other modules are added as examples only and are not required.

 Quantity Catalog Number Description
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Conventions This manual uses the following conventions.

Additional Resources

Convention Meaning Example

bold Bold text denotes menus, menu items, buttons or options. Click OK.

Check/uncheck Click to activate/deactivate a checkbox. Check the Do not show this dialog again 
checkbox.

Click Click left mouse button once. (Assumes cursor is positioned on 
object or selection.)

Click Browse. 

Courier 
font

Type or enter text exactly as shown. Type cmd.

Double-click Click left mouse button twice in quick succession. (Assumes 
cursor is positioned on object or selection.)

Double-click the H1 icon. 

Expand Click the + to the left of a given item /folder to show its 
contents.

In the H1-1 window, expand the FFLD.

Right-click Click right mouse button once. (Assumes cursor is positioned on 
object or selection.)

Right-click the Fieldbus Networks icon. 

Select Click to highlight a menu item or list choice. Select Properties from the drop-down list.

> Shows nested menu selections as menu name followed by menu 
selection.

Click File > Page Setup > Options. 

Resource Description

1769 CompactLogix Controllers Selection 
Guide, publication 1769-SG001

Provides information and specifications for consideration when selecting CompactLogix 
controllers and software. 

1769 Compact I/O Selection Guide, publication 
1769-SG002

Provides information and specifications for consideration when selecting I/O modules 
for use with the CompactLogix system. Includes Compact I/O, POINT I/O, and FLEX I/O 
modules.

NetLinx Selection Guide, publication 
NETS-SG001

Provides information and specifications for consideration when selecting a network to 
use and which hardware and cables you need.
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Notes:
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Chapter 1

Prepare the CompactLogix Hardware

In this chapter, you install your CompactLogix hardware, including the controller, power 
supply, any local 1769 Compact I/O modules, and an optional 1769-SDN module (used only 
if you have distributed I/O on the DeviceNet network).

Before You Begin

Determine which of these networks and appropriate hardware to use:

• For the EtherNet/IP network (option 1), use the 1769-L32E or 1769-L35E controller.
• For the ControlNet network (option 2), use the 1769-L32C or 1769-L35CR controller.
• For a serial connection (option 3), use the 1769-L31 controller.
• For the DeviceNet network (options 2 and 3), use the 1769-SDN module with the 

1769-L31 controller.

What You Need

• CompactLogix controller: 1769-L32E, 1769-L35E, 1769-L32C, 1769-L35CR, or 
1769-L31

• CompactLogix controller battery: 1769-BA (included with your controller)

• Compact power supply: 1769-PA2

• Compact I/O end cap: 1769-ECR

• Compact I/O module: this example uses a 1769-OB16 module. Other Compact I/O 
modules can also be used, but are not required

• Compact I/O DeviceNet scanner module: 1769-SDN (only if you are using a 
DeviceNet network)

• Network cable: Ethernet (commercially available), ControlNet (1786-TPR), or 
serial (1756-CP3)
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Chapter 1        Prepare the CompactLogix Hardware
Follow These Steps

Complete the steps shown for your controller.

Connect the 
Battery to the 

Controller

1769-L32E, 
1769-L35E

1769-L32C, 
1769-L35CR 1769-L31

Record the 
Ethernet Address 

(MAC)

Assemble the 
System

Make Network 
Connections

Wire Power

Connect the 
Battery to the 

Controller

Set the ControlNet 
Node Address

Assemble the 
System

Make Network 
Connections

Wire Power

Connect the 
Battery to the 

Controller

Assemble the 
System

Make Network 
Connections

Wire Power

page 19

page 19 page 20

page 21

page 22

page 25

page 25

page 22

page 21

page 19

page 25

page 22

page 21

page 19
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Prepare the CompactLogix Hardware         Chapter 1
Connect the Battery to the Controller

1769-BA Battery

Record the Ethernet Address (MAC)

1769-L32E or 1769-L35E controllers

The Ethernet address (MAC) is found on a label near the battery. This is an example address.

Record the Ethernet address (MAC) for the CompactLogix controller on the Network 
Worksheet at the back of this quick start. This address is used to set the IP address later.

1. Insert the battery and battery 
connector.

2. Record the battery installation 
date in the box provided on 
the label. Battery

Battery Connector

Ethernet Address Box for Battery 
Installation Date

00:00:BC:21:D7:BE
Ethernet Address
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Chapter 1        Prepare the CompactLogix Hardware
Set the ControlNet Node Address

1769-L32C or 1769-L35CR controllers

00
90

7
080

6
0

50

4030
2
0

1
0

0

9

7

8

6
5

43
2

1

Tens 
Digit

Ones
Digit

1. Use a small, flathead screwdriver to set the 
node address to node 01.

2. Record the node address on the front panel 
overlay.

Controllers are shipped with 
the node address set at 99.

01 Shown

ControlNet Node Address Switches

Ones

Tens

Ones

Tens
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Prepare the CompactLogix Hardware         Chapter 1
Assemble the System

Controller, power supply, local I/O modules, 1769-SDN module, end cap terminator

Unlocked

Locked

Tongue-and-groove Slots

1. On the top of each module, verify that all of the 
locking tabs are unlocked.

2. Use the tongue-and-groove slots to slide the 
power supply, then the I/O modules onto the 
controller.

3. If you have an 1769-SDN module, record the 
series letter (see label on the side of the module) 
on the Network Worksheet inside the back cover 
of this quick start.

4. If you have an 1769-SDN module, slide it onto 
the other modules.

There can be a maximum of three modules 
between the 1769-SDN module and the power 
supply.

Controller
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Chapter 1        Prepare the CompactLogix Hardware
Make Network Connections

1769-L32E or 1769-L35E controllers

5. Lock all of the locking tabs on the top 
of the modules.

6. Verify that the tabs are all the way to the 
left.

7. Slide the end cap terminator on and 
lock the locking tab.

8. Press the assembled system onto a DIN 
rail.

Locking 
Tab

End-cap Terminator

8 ------ NC
7 ------ NC
6 ------ RD-
5 ------ NC
4 ------ NC
3 ------ RD+
2 ------ TD-
1 ------ TD+

1. Insert an Ethernet cable with an RJ-45 
connector.

2. Connect the other end of the cable to an 
Ethernet switch.

Ethernet Port
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Prepare the CompactLogix Hardware         Chapter 1
1769-L32C or 1769-L35CR controllers

Required for all CompactLogix controllers

A
B

A

Connect a ControlNet tap to port 
A of the controller.

Port 
A

Port B 
(Do not use.)

1. Connect the 1756-CP3 cable to the channel 
0 serial port on the controller.

2. Connect the other end of the cable to a 
COM port on the computer.
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Chapter 1        Prepare the CompactLogix Hardware
1769-SDN module

1. Connect a DeviceNet cable to the 
removable connector.

2. Connect the removable connector to the 
module.

Connect To

Red V+

White CAN High

Bare Shield

Blue CAN Low

Black V-
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Prepare the CompactLogix Hardware         Chapter 1
Wire Power

1769-PA2 power supply

PWR OUT +24V DC

PWR OUT COM

120/240V AC

V AC COM

CHASSIS GROUND

1. Insert the 120/240V AC, V AC COM, and Chassis Ground wires and tighten the 
terminal screws.

2. Turn on incoming power.

WARNING

Verify that all incoming power is turned off before wiring power.

Terminal Wiring Diagram
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Chapter 1        Prepare the CompactLogix Hardware
Additional Resources

Resource Description

1769-L32E and 1769-L35E CompactLogix 
Controller Installation Instructions, publication 
1769-IN020

Provides details about assembling and mounting the controller and upgrading firmware 
as well as controller technical specifications.

1769-L32C and 1769-L35CR CompactLogix 
Controller Installation Instructions. publication 
1769-IN070

Provides details about assembling and mounting the controller and upgrading firmware 
as well as controller technical specifications.

1769-L31 CompactLogix Controller Installation 
Instructions, publication 1769-IN069

Provides details about assembling and mounting the controller and upgrading firmware 
as well as controller technical specifications.

1769-SDN Compact I/O DeviceNet Scanner 
Module Installation Instructions, publication 
1769-IN060

Provides information about installing the 1769-SDN module and technical 
specifications.

Compact 1769 Expansion I/O Power Supplies 
Installation Instructions, publication 
1769-IN028

Provides details on power considerations, master control relay, safety circuits, 
grounding, power dissipation, input power requirements, and technical specifications.
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Chapter 2

Prepare the Computer

In this chapter, you configure network communication on your computer and install the 
necessary programming and configuration software.

Before You Begin

• Verify that your computer meets the software’s system requirements for your edition of RSLogix 5000 
programming software.

• If using a ControlNet network (option 2), install a 1784-PCIC or 1784-PCICS ControlNet 
communication card on the computer.

What You Need

• RSLinx Classic software, version 2.54 or later (packaged with RSLogix 5000 programming software).
• RSLogix 5000 programming software (see the Preface for version and edition information)
• RSNetWorx for ControlNet software for the ControlNet network
• RSNetWorx for DeviceNet software for the DeviceNet network
• ControlFlash software (packaged with RSLogix5000 programming software)
• BOOTP/DHCP server utility (packaged with RSLogix 5000 programming software).
• A Network Interface Card (NIC) and its associated Windows driver installed (the NIC and driver are 

standard on most computers).
• An Ethernet Address (MAC) for each device. You recorded these addresses in the Network Worksheet 

on the back cover.
• A planned IP Address for each device. If you are using an isolated network, determine a numbering 

convention for your IP addresses. Record these addresses on the Network Worksheet inside the back 
cover.
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Chapter 2        Prepare the Computer
Complete these steps.

Terminology

Install RSLogix 
Programming 

Software

Configure a Serial 
Driver

Configure the 
EtherNet/IP 

Driver in RSLinx 

Install Additional 
Software

Load Firmware

Optional
(Depending on your system.)

page 29

page 38

page 44

page 40

page 42

page 36

page 31

Set the IP 
Address for 
the Computer
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Prepare the Computer         Chapter 2
Terminology

Ethernet networks use these types of addresses.

Make Network Connections

Ethernet connection - Required for all options

Term Definition

Ethernet Address Each Ethernet device has a unique Ethernet address (sometimes called a MAC address). The 
address appears as twelve digits separated by colons (for example, xx:xx:xx:xx:xx:xx). It is 
usually on a label on the device itself. 

Each digit is a number in hexadecimal (0 to 9 or A through F). No other device in the world will 
have the same address, and it can not be changed.

You use the Ethernet address to identify a device so you can assign it an IP address.

IP Address In addition to the Ethernet address, an IP address identifies a node on an Ethernet network. 
The IP address can be manually set. or you can use special software to automatically assign it.

An IP Address consists of four decimal integers separated by periods (xxx.xxx.xxx.xxx). Each xxx 
is a decimal value from 0…255. For example, an IP Address could be 192.168.1.092 The 
selection of IP Addresses is beyond the scope of this quick start, so please contact your 
network administrator or use the ones provided in the examples.

Once you set an IP address for a device, you generally reference the device by its IP address. 
The examples in this quick start use IP Addresses to define communication paths to the 
devices.

Connect the Ethernet port of the computer to 
the Ethernet switch.

Stratix 6000 Switch

Computer with 
standard Ethernet port.
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Chapter 2        Prepare the Computer
ControlNet connection - 1769-L32C and 1769-L35CR controllers only

Serial connection - Required for all controllers

Connect a ControlNet tap to port A of the 
ControlNet communication card in the 
computer.

ControlNet Tap on 
ControlNet Network

Computer with 1784-PCIC or 
1784-PCICS communication 
card.

You connected a 1756-CP3 cable to a COM port on the computer and to the CH0 port 
on the controller in Chapter 1.

1756-CP3 serial cable to CH0 on 1769-L31.
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Prepare the Computer         Chapter 2

gix 5000 installation settings 
Install RSLogix Programming Software

Required for all controllers

3. Accept the default 
software products for 
installation and click 
Next.

Throughout the installation, click Next to use default RSLo
except when indicated in the steps below.

1. Begin the RSLogix 5000 
software installation.

2. Choose your language and 
click Continue.

4. Enter your user name, organization, and 
software serial number, then click Next.
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Chapter 2        Prepare the Computer
7. Select your 
activation type 
and click Next.

This quick start uses 
FactoryTalk 
Activation software 
to activate RSLogix 
5000 software. For 
more information, 
see the FactoryTalk 
Activation FAQ, 
publication 
Ftalk-FA017.

5. Accept the license agreement and 
click Next.

8. Click Next to 
install only the 
latest version of 
RSLogix 5000 
software (version 
18).

9. Verify that 
RSLogix 5000 
Tools and Files is 
checked and click 
Next.

6. Click Next to install the program 
files to the default directory.
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Prepare the Computer         Chapter 2
10. Click Next to 
install the typical 
firmware kits.

11. Click Next to install 
typical RSLogix 
Architect tools.

12. Click Next to install 
the typical set of 
EDS files and 
RSLinx software.
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Chapter 2        Prepare the Computer
13. Click Install to 
complete the 
installation.

The installation 
dialog box displays 
progress while the 
software installs.

TIP As the installation progresses, you may be prompted to complete additional set-up tasks depending on 
your system configuration. Follow those prompts and enter information as indicated in the dialog boxes to 
complete your installation.

After a few moments, the 
FactoryTalk Installation Wizard 
starts.

14. Click Next.

15. Enter the Serial number and 
Product key from the 
certification letter packaged with 
your software.

16. Click Next.
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Prepare the Computer         Chapter 2
17. Select your host ID and click 
Next.

The activation completes if the 
computer is connected to the 
Internet.

If Internet access is not 
available, call Rockwell 
Automation Technical Support 
to complete your activation.

18. Click Finish to close the 
Activation Wizard.
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Chapter 2        Prepare the Computer
Configure a Serial Driver

Required for all controllers

1. Launch RSLinx 
software.

2. Under Communications, select Configure 
Drivers.

3. Select RS-232 DF1 devices.

4. Click Add New.

5. Click OK to keep the default 
name.
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Prepare the Computer         Chapter 2
The Serial driver is added to the 
Configured Drivers list.

10. Verify that the Status of the driver 
is Running, and click Close.

11. Click the RSWho icon to view 
the driver.

All of the configured, active drivers 
display.

6. Select the Comm Port to which you 
connected the 1756-CP3 cable.

7. For Device, select 
Logix5550/CompactLogix.

8. Click Auto Configure.

9. Click OK.

Expand the serial driver to see 
connected devices.
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Chapter 2        Prepare the Computer
Set the IP Address for the Computer

Required for all controllers, regardless of network choice

1. On your desktop, right-click My 
Network Places and select 
Properties.

2. Double-click the Local Area 
Connection.

3. Click Properties.

4. On the General tab, select Internet 
Protocol (TCP/IP) and click 
Properties.

5. Select Use the following IP address 
and enter an IP address and Subnet 
mask for your computer using the 
example shown or enter your own 
address.

For more information about selecting 
an IP Address, see page 81.

6. Click OK.
7. Record the IP address and subnet mask in the Network Worksheet on the back cover.

8. Click OK.
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Prepare the Computer         Chapter 2
9. Click the Support tab.

10. Verify that the IP Address and 
Subnet Mask match what you entered 
on the Network Worksheet.

If these numbers do not match what 
you entered, contact your network 
administrator to verify that your IP 
address is correct.

11. Close the Local Area Connection 
Status dialog box.
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Chapter 2        Prepare the Computer
Configure the EtherNet/IP Driver in RSLinx Software

Required for 1769-L32E,1767-L35E, and PanelView Plus

1. If RSLinx software is not open, launch RSLinx software.

2. From the Communications 
menu, choose Configure 
Drivers.

3. From the Available 
Driver Types, select 
Ethernet/IP Driver.

4. Click Add New.

5. Click OK to keep the default 
name.

6. Click OK to Browse Local 
Subnet.
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Prepare the Computer         Chapter 2
The EtherNet/IP driver is 
added to the Configured 
Drivers list.

7. Verify that the driver’s 
Status is Running, and click 
Close.
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Chapter 2        Prepare the Computer
Load Firmware

Required for all packaged controllers

TIP This example shows how to load firmware using a serial connection. It is faster to load firmware 
via an EtherNet/IP or ControlNet connection. For more information, see the installation 
instructions for the controller as listed at the end of the chapter.

1. Launch ControlFlash software.

2. Click Next.

3. Select the controller catalog 
number and click Next.
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Prepare the Computer         Chapter 2
6. Move the keyswitch 
on the controller to 
PROG.

7. If the Current Revision matches the 
revision of firmware you want, click 
Cancel and skip to Chapter 3.

Otherwise, select the desired firmware 
revision and click Next.

8. Click Finish to start the firmware 
update.

4. Expand the AB_DF1-DFI driver, 
and select your controller.

5. Click OK.
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Chapter 2        Prepare the Computer
Install Additional Software

• If you are completing the PanelView Plus chapters in this quick start, install FactoryTalkView Machine 
Edition software and RSLinx Enterprise software from the FactoryTalkView Machine Edition 
package. This software must be installed before you install any additional software.

• If you are using a ControlNet network, install RSNetWorx for ControlNet software.
• If you are using a DeviceNet network, install RSNetWorx for DeviceNet software.
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Prepare the Computer         Chapter 2
Additional Resources

Resource Description

1769-L32E and 1769-L35E CompactLogix 
Controller Installation Instructions, publication 
1769-IN020

Provides details about assembling and mounting the controller and upgrading firmware 
as well as controller technical specifications.

1769-L32C and 1769-L35CR CompactLogix 
Controller Installation Instructions. publication 
1769-IN070

Provides details about how to assemble and mount the controller, how to upgrade 
firmware, and controller technical specifications.

1769-L31 CompactLogix Controller Installation 
Instructions, publication 1769-IN069

Provides details about assembling and mounting the controller and upgrading firmware 
as well as controller technical specifications.

FactoryTalk Activation FAQ, publication 
FTalk-FA017

Provides answers to FactoryTalk Activation questions, including how the FactoryTalk 
Activation differs from master disk activation.

ControlFlash Firmware Upgrade Kit, publication 
1756-QS105

Provides details regarding the installation of ControlFlash software and execution of 
firmware upgrades.
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Chapter 3

Prepare the Distributed POINT I/O Hardware

In this chapter, you install the 1734 POINT I/O network adapter and the 1734 POINT I/O 
modules.

Before You Begin

• Determine which of these network adapters to use:

– for an EtherNet/IP network (option 1), use the 1734-AENT adapter.

– for a ControlNet network (option 2), use the 1734-ACNR adapter.

– for a DeviceNet network (option 3), use the 1734-ADN adapter.

• Select the appropriate mounting base for I/O modules:

– if you use a 1734-IT2I module, then use the 1734-TBCJC.

– for all other I/O modules use the 1734-TB or 1734-TBS.

What You Need

• POINT I/O adapter: 1734-AENT, 1734-ACNR, and/or 1734-ADN

• POINT I/O mounting bases: 1734-TB or 1734-TBS, and 1734-TBCJC

• A digital-output POINT I/O module: The examples use a 1734-OB4E, however, other 
POINT I/O modules can also be used, but are not required

• Power supply: 1794-PS3 or 1794-PS13
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Follow These Steps

If you have a POINT I/O system, complete these steps.

Mount and Connect 
the Network 

Adapter

Mount the POINT 
I/O Modules

Mount and Wire the 
POINT I/O Power 

Supply

Wire the Adapter 
and I/O Modules to 
the Power Supply

page 49

page 53

page 52

page 51
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Prepare the Distributed POINT I/O Hardware         Chapter 3
Mount and Connect the Network Adapter

EtherNet/IP 1734-AENT adapter

ControlNet 1734-ACNR adapter

1. Locate the Ethernet address (MAC), found 
next to the label. Record the Ethernet address 
(MAC) for the POINT I/O adapter on the 
Network Worksheet.

This address is used to set the IP address later 
in the quick start.

2. Set the address to a value greater than or 
equal to 256.

This example uses 999.

3. Remove the safety end cap.

4. Press the adapter onto the DIN rail.

5. Insert an Ethernet cable.

Go to Mount the POINT I/O Modules.

00:00:BC:21:44:8A
Ethernet Address

Example Address

1. Remove the safety end cap.

2. Press the adapter onto the DIN rail.

3. Set the node address.

This example uses node 02.

4. Connect a ControlNet tap to the A port.

Go to Mount the POINT I/O Modules.
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DeviceNet 1734-ADN adapter

1. Remove the safety end cap.

2. Press the adapter onto the DIN rail.

3. Set the node address.

This example uses node 02.

4. Connect the DeviceNet cable to the 
removable connector.

5. Connect the removable connector to the 
adapter.

Go to Mount the POINT I/O Modules.

Connect To

Red V+

White CAN High

Bare Shield

Blue CAN Low

Black V-

DeviceNet Connector and Port
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Prepare the Distributed POINT I/O Hardware         Chapter 3
Mount the POINT I/O Modules

All controllers, POINT I/O modules, and wiring bases

1. Using a small, flathead screwdriver, rotate the 
keyswitch to match the figure on the I/O 
module.

2. Press the module into the wiring base.

3. Snap the handle up.

4. Complete steps 1–3 with all POINT I/O 
modules.

5. Slide the first module and wiring base 
assembly along the adapter and press it 
onto the DIN rail.

6. Repeat with all of the I/O assemblies.

Handle

Tongue-and-groove Slots

ATTENTION The 1734-IT2I module must be mounted in the 1734-TBCJC wiring base. All other modules can be 
mounted in either of the 1734-TB or 1734-TBS wiring bases.

Figure on Module

Wiring Base

Module
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Mount and Wire the POINT I/O Power Supply

1794-PS3 or 1794-PS13 power supplies
1. Hook the upper-lip of the DIN rail latch onto the

DIN rail.

2. Press the module onto the DIN rail.

3. Connect the 
120/230V AC 
power, 120/230V 
AC common and 
AC Ground wires.

WARNING

Verify that all incoming power is turned off before wiring power.

Upper-lip of DIN rail latch.

rewoP
CD V42
YLPPUS REWOP
3SP-4971

V42

MOC

GR
L2/N
L1

L2
L1

Top View
52 
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Prepare the Distributed POINT I/O Hardware         Chapter 3
Wire the Adapter and I/O Modules to the Power Supply

POINT I/O adapter, I/O modules, and power supply

Additional Resources

Resource Description

Point I/O Ethernet Adapter Installation 
Instructions, publication 1734-IN590

Provides details regarding installation of the adapter and technical specifications.

1734 Point I/O ControlNet Adapter Installation 
Instructions, publication 1734-IN582

Provides details regarding installation of the adapter and technical specifications.

Point I/O DeviceNet Adapter Installation 
Instructions, publication 1734-IN026

Provides details regarding installation of the adapter and technical specifications.

POINT I/O Wiring Base Assembly Installation 
Instructions, publication 1734-IN511

Provides details regarding installation of the POINT I/O wiring base.

Cold Junction Compensated Terminal Block 
Installation Instructions, publication 
1734-IN583

Provides details regarding installation of the Cold Junction Compensated Terminal 
Block wiring base.

Point I/O Protected Output Module Installation 
Instructions, publication 1734-IN056

Provides details about the installation and wiring of POINT I/O Protected Output 
Modules.

FLEX I/O DC Power Supply Modules Installation 
Instructions, publication 1794-IN069

Provides details about the installation and wiring of FLEX I/O power supplies.

Common
Power

1. Connect the 12/24V DC 
common and 12/24V DC 
power wires from the power 
supply to the adapter.

2. Refer to the individual POINT 
I/O installation instructions for 
wiring the I/O modules.

3. Turn on incoming power.
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Chapter 4

Prepare the PowerFlex 70 Drive

In this chapter, you mount and wire power to a PowerFlex 70 drive. You also configure your 
communication adapter and make network connections.

Before You Begin

Determine which network and appropriate adapter to use on the PowerFlex 70 drive:

• For an EtherNet/IP network (option 1), use the 20-COMM-E module.
• For a ControlNet network (option 2), use the 20-COMM-C module.
• For a DeviceNet network (option 3), use the 20-COMM-D module.

What You Need

• PowerFlex 70 drive

• Communication adapter for use with the PowerFlex 70 drive: 20-COMM-E 
(EtherNet/IP adapter), 20-COMM-C (ControlNet adapter), or 20-COMM-D 
(DeviceNet adapter)
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Follow These Steps

If you have a PowerFlex 70 drive, complete these steps.

Mount the 
PowerFlex 70 Drive

Wire Power

Configure the 
Communication 

Adapter

Connect 
Communication 
Adapter to the 

PowerFlex 70 Drive

page 57

page 59

page 58

page 57
56 Publication IASIMP-QS001C-EN-P - October 2009



Prepare the PowerFlex 70 Drive         Chapter 4
Mount the PowerFlex 70 Drive

For the purpose of this quick start, the PowerFlex 70 drive can be propped in a safe and 
convenient location.

For mounting instructions, see the PowerFlex 70 Drive User Manual, publication 
20A-UM001.

Wire Power

1. Loosen the screw and remove the cover.

2. Loosen the screws and slide the metal plate out 
of the drive.

3. Connect the 120/240V AC, V AC COM and 
chassis ground wires to the terminal block.

4. Replace the metal plate and tighten the screws.

Connect To

120/240V AC L1
R

V AC COM L2
S

Chassis ground PE

WARNING
Verify that all incoming power is 
turned off before wiring power.

L1
R

L2
S

L3
T

BR1
+DC

BR2
BRK

T1
U

T2
V

T3
W

PE PE

19
5-

26
5 V

AC
 LI

NE
, 5

0/
60

 H
z 

L3 

L2 

L1 

230 VAC SUPPLY 

CTRL2 

CTRL1 

19
5-

26
5 V

AC
 LO

AD
, 5

0/
60

 H
z 

L3' 

L2' 

L1' 

CONTROL VAC  

AUX2 

AUX2 

AUX1 

AUX1 

I/O_COM 

I/O_PWR 

I/O_COM 

I/O_PWR 

I/O_COM 

I/O_PWR 

24 VDC SUPPLY 

1  
2 

1   2   3   4 
1   2   3   4 

1  
 2 

  3
   4

 
1 2

  3
  4

  5
  6

 

AUX1 

Optional LIM 240V 
AC 

3-Phase Load 
Connector

Motor

fus

Top View
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Configure the Communication Adapter

Adapter Action Figure

EtherNet/IP
20-COMM-E

The Ethernet address (MAC) is found on 
the adapter’s label. Record the Ethernet 
address (MAC) on the Network 
Worksheet. This address is used to set 
the IP address later in the quick start.

For example:

ControlNet
20-COMM-C

Set the adapter’s node address.

The quick start examples use node 
number 4.

DeviceNet
20-COMM-D

1. Set the adapter’s node address.

The quick start examples use node 
number 13.

2. Set the adapter for autobaud.

HW Address 00:00:BC:21:D7:BE

2
1

0

9
8

3
4

5

6
7

2
1

0

9
8

3
4

5

6
7

Tens 
Digit

Ones
Digit

A B

4 Shown

2
1

0

9
8

3
4

5

6
7

2
1

0

9
8

3
4

5

6
7

Tens 
Digit

Ones
Digit

13 Shown

PGM500K
250K
125K

AUTO

AUTO Shown
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Connect Communication Adapter to the PowerFlex 70 Drive

20-COMM-D DeviceNet Adapter for DeviceNet System

1. Connect the flat-ribbon 
cable between the adapter 
and the PowerFlex 70 
drive.

2. Fold the cable under 
adapter without creasing 
and secure adapter on 
drive using the captive 
screws.

3. Remove a knockout from 
the bottom plate on the 
drive and route the 
DeviceNet network cable 
through the hole.

4. Wire the KwikLink QD 
Micro Cordset to the 
20-COMM-D connector. 

5. Connect the QD Micro 
Cordset to a KwikLink 
sealed micro connector 
on the DeviceNet 
network.

6. Replace drive cover.

Connect To

Red V+

White CAN High

Bare Shield

Blue CAN Low

Black V-

POINT I/O with
1734-ADN Adapter

KwikLink Sealed
Terminator

KwikLink Sealed
Terminator

KwikLink Sealed
Micro Connector

1606-XLDNET8
Power Supply

1769-SDN
DeviceNet Module
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20-COMM-E EtherNet/IP Adapter for EtherNet/IP System

1. Connect the flat-ribbon 
cable between the adapter 
and the PowerFlex 70 
drive.

2. Fold the cable under the 
adapter without creasing 
and secure the adapter on 
the drive using the captive 
screws.

3. Remove a knockout from 
the bottom plate on the 
drive route the Ethernet 
cable through the hole.

4. Connect a CAT5 
Ethernet cable between 
the Ethernet adapter and 
the Ethernet switch.

5. Replace drive cover.
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Additional Resources

Resource Description

PowerFlex 70 User Manual, publication 
20A-UM001

Provides details on how to install, program, and edit parameters for the PowerFlex 70 
drive. 

PowerFlex 70 EtherNet/IP Adapter User 
Manual, publication 20COMM-UM010

Provides details on how to install, configure, and use the adapter.

PowerFlex 70 ControlNet Adapter User Manual, 
publication 20COMM-UM003

Provides details on how to install, configure, and use the adapter.

PowerFlex 70 DeviceNet Adapter User Manual, 
publication 20COMM-UM002

Provides details on how to install, configure, and use the adapter.
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Chapter 5

Prepare the PowerFlex 40 Drive

In this chapter, you mount and wire power to a PowerFlex 40 drive. You also configure your 
communication adapter and make network connections.

Before You Begin

Determine which of these networks and appropriate adapter to use:

• For an EtherNet/IP network (option 1), use the 22-COMM-E.
• For a ControlNet network (option 2), use the 22-COMM-C.
• For a DeviceNet network (option 3), use the 22-COMM-D.

What You Need

• PowerFlex 40 drive

• Communication adapter for use with the PowerFlex 40 drive: 22-COMM-E 
(EtherNet/IP adapter), 22-COMM-C (ControlNet adapter) or 22-COMM-D 
(DeviceNet adapter)

• Communication adapter cover for use with the PowerFlex 40
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Follow These Steps

If you have a PowerFlex 40 drive, complete these steps.

Mount the 
PowerFlex 40 Drive

Wire Power

Configure the 
Communication 

Adapter

Connect the 
Communication 
Adapter to the 

PowerFlex 40 Drive

page 65

page 65

page 66

page 67
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Prepare the PowerFlex 40 Drive         Chapter 5
Mount the PowerFlex 40 Drive

For mounting instructions, see the PowerFlex 40 Drive User Manual, publication 
22B-UM001.

Wire Power

1. Remove the cover.

V/T2T/L3S/L2R/L1 U/T1 W/T3

BR+ BR-DC- DC+

2. Remove the terminal block cover to 
access the power connections.

3. Insert the 120/240V AC, V AC COM 
and chassis ground wires and tighten 
the terminal screws.

Connect To

120/240V AC R/L1

V AC COM S/L2

Chassis ground

WARNING Verify that all incoming power 
is turned off before wiring 
power.
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Configure the Communication Adapter

Adapter Action Figure

EtherNet/IP
22-COMM-E

The Ethernet address (MAC) is found on 
the adapter’s label. Record the Ethernet 
address (MAC) on the Network 
Worksheet. This address is used to set 
the IP address.

For example: 

ControlNet
22-COMM-C

Set the adapter’s node address.

This example uses node number 3.

Important: The front side of the adapter 
(shown here) faces down when it is 
installed in the drive. So, in the installed 
position, port A is to the right of port B.

DeviceNet
22-COMM-D

1. Set the adapter’s node address.

This example uses node number 3.

2. Set the rate to Autobaud.

HW Address 00:00:BC:21:D7:BE

2

1

0

9

8

3

4

5

6

7

2

1

0

9

8

3

4

5

6

7

Tens Digit Ones Digit

A B  Node 3 shown

Node Switch

1 2 3 4 5 6

0 0 0 0 0 0 0

1 1 0 0 0 0 0

2 0 1 0 0 0 0

3 1 1 0 0 0 0

4 0 0 1 0 0 0

5 1 0 1 0 0 0

6 0 1 1 0 0 0

Rate Switch

7 8

125 Kbps 0 0

250 Kbps 1 0

500 Kbps 0 1

Autobaud 1 1

21 83 4 5 6 7

NODE RATE

21 83 4 5 6 7

Up =  1  = 

Down =  0 = 

Node 3 Shown
Autobaud Shown
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Connect the Communication Adapter to the PowerFlex 40 Drive

22-COMM-E, 22-COMM-C, 22-COMM-D adapter
1. If you are using a DeviceNet network, remove the terminal block connector from the 

22-COMM-D adapter and connect the DeviceNet cable to the terminal block.

2. For all adapters, attach the extending screws.

Connect To

Red V+

White CAN High

Bare Shield

Blue CAN Low

Black V-

0.8…1 Nm (7…9 lb•in)
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0.5-0.6 N-m
(4-5 lb.-in.)

4. Place the adapter cover on the PowerFlex.

5. Tighten the screws.

6. For all networks, connect the network cable to the 
adapter.

7. Apply power to the PowerFlex 40 drive.

Important: The front side of the ControlNet adapter faces down 
when it is installed in the drive. So, in the installed position, port 
A is to the right of port B.

3. Snap the adapter into the cover and connect the cable from the adapter to the 
PowerFlex 40 drive.

0.5…0.6 Nm 
(4…5 lb-in)
68 
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Prepare the PowerFlex 40 Drive         Chapter 5
Additional Resources

Resource Description

PowerFlex 40 Adjustable Frequency AC Drive 
User Manual, publication 22B-UM001

Provides details on how to install, program, and edit parameters for the PowerFlex 40 
drive. 

PowerFlex 40 EtherNet/IP Adapter User 
Manual, publication 22COMM-UM004

Provides details on how to install, configure, and use the adapter.

PowerFlex 40 ControlNet Adapter User Manual, 
publication 22COMM-UM006

Provides details on how to install, configure, and use the adapter.

PowerFlex 40 DeviceNet Adapter User Manual, 
publication 22COMM-UM003

Provides details on how to install, configure, and use the adapter.
Publication IASIMP-QS001C-EN-P - October 2009 69

http://literature.rockwellautomation.com/idc/groups/literature/documents/um/22b-um001_-en-e.pdf
http://literature.rockwellautomation.com/idc/groups/literature/documents/um/22comm-um004_-en-p.pdf
http://literature.rockwellautomation.com/idc/groups/literature/documents/um/22comm-um006_-en-p.pdf
http://literature.rockwellautomation.com/idc/groups/literature/documents/um/22comm-um003_-en-p.pdf


Chapter 5        Prepare the PowerFlex 40 Drive
Notes:
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Chapter 6

Prepare the PanelView Plus Terminal

In this chapter, you mount and wire power to a PanelView Plus terminal. You also configure 
network communication and make network connections.

Before You Begin

Determine which network connection to use: EtherNet/IP, ControlNet, or serial.

Regardless of which CompactLogix controller you use, you need to connect to the PanelView 
Plus terminal via an EtherNet/IP network for initial configuration, via a cross-over cable or 
an Ethernet switch.

What You Need

• PanelView Plus terminal

• For a ControlNet network (option 2), use a PanelView Plus ControlNet interface 
module

• One power supply, either a 1794-PS3 or a 2711P-RSACDIN

• Ethernet cable and switch or Ethernet cross-over cable

• For a serial connection (option 3), 2706-NC13 cable
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Chapter 6        Prepare the PanelView Plus Terminal
Follow These Steps

If you have a PanelView Plus terminal, complete these steps for your network.

EtherNet/IP ControlNet Serial

Install the 
ControlNet 

Interface Module
page 73

Mount the 
PanelView Plus 

page 73

Wire the 
PanelView Plus 
Terminal to the 

page 74

Make Network 
Connections

page 75

Mount the 
PanelView Plus 

page 73

Wire the 
PanelView Plus 
Terminal to the 

page 74

Make Network 
Connections

page 75

1769-L31 
controller

page 76

Mount the 
PanelView Plus 

page 73

Wire the 
PanelView Plus 
Terminal to the 

page 74

Make Network 
Connections

page 75
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Install the ControlNet Interface Module

ControlNet only

Mount the PanelView Plus Terminal

2711P-K10C4D1 terminal and all controllers

For the purpose of this quick start, the PanelView Plus can be propped on a desktop. 

For mounting instructions, see the PanelView Plus Terminals User Manual, publication 
2711P-UM001.

1. Remove the label covering the communication 
module connector on the logic module.

2. Position the communication module over the logic module 
so the connectors align.

3. Push down on the communication module until connectors 
are firmly seated.

4. Tighten the 4 screws that secure the communication module 
to the logic module.

Logic Module

Communication Module
Publication IASIMP-QS001C-EN-P - October 2009 73

http://literature.rockwellautomation.com/idc/groups/literature/documents/um/2711p-um001_-en-p.pdf


Chapter 6        Prepare the PanelView Plus Terminal
Wire the PanelView Plus Terminal to the Power Supply

rewoP
CD V42
YLPPUS REWOP
3SP-4971

V42

MOC

+ –

1. Remove the terminal block from the PanelView Plus terminal.

WARNING

Verify that all incoming power is turned off before wiring power.

Common
Power

2. Connect the 12/24V DC common and 
12/24V DC power wires from the power 
supply to the terminal block, 
- (common) and + (power).

3. Connect the terminal block to the 
PanelView Plus.

4. Turn on incoming power.
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Make Network Connections

Required for all controllers 

1769-L32C or 1769-L35CR controllers

Connect an Ethernet cable. 
Connect the other end of the cable to an 
Ethernet switch.

Connect a ControlNet cable to port A. 
Connect the tap to the ControlNet network.
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Chapter 6        Prepare the PanelView Plus Terminal
1769-L31 controller

Connect the 2706-NC13 cable 
to the serial port. Connect the 
other end of cable to the 
Channel 1 port on the 1769-L31 
controller.

1756-CP3 Serial Cable to 
Channel 0 Port
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Diagnostics Setup
Display
File Management
Font Linking
Input Devices
Networks and Communications
Print Setup
Startup Options
System Event Log
System Information
Time/Date/Regional Settings 
Assign an IP Address

Required for all Ethernet/IP 
System

1. Apply power to the 
PanelView terminal.

2. On the initial PanelView 
configuration screen, 
select Terminal Settings 
[F4].

3. Navigate to
Built-in Ethernet 
Controller by selecting 
the path shown.

4. Select IP Address [F2].

Networks and Communications

Network Connections

Network Adapters

Built-in Ethernet Controller
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Chapter 6        Prepare the PanelView Plus Terminal
5. Select IP Address [F1].

a. Enter an IP address in 
the input panel.

b. Press Enter.

c. Record IP address in 
Appendix A.

For information on IP 
addresses, see Chapter 7.

6. Select Subnet Mask [F2].  

a. Enter the subnet mask 
you wrote on the Network 

Worksheet. 

b. Press Enter.

7. Select OK [F7] to save 
settings, then OK [F7] 
again to acknowledge 
reset message.
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8. Select Close [F8] until 
you return to the initial 
configuration screen.

9. Select Reset [F8] to reset 
the terminal, then 
Yes [F7] to confirm.
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Additional Resources

Resource Description

PanelView Plus Terminals User Manual, 
publication 2711P-UM001

Provides details on how to install, program, and edit parameters for the PowerFlex 70 
drive. 
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Chapter 7

Configure the EtherNet/IP Network

In this chapter, you assign IP addresses to devices on an EtherNet/IP network.

Before You Begin
• Prepare the computer, see Chapter 2

• Install all hardware, see Chapters 1–6

If you connect all of the devices, including the computer, through an Ethernet switch, 
you can create an isolated network. This chapter assumes you are using an isolated 
network. If you are not, contact your network administrator to obtain IP addresses.

• Verify that power is applied to all devices.

What You Need
• The computer needs a Network Interface Card (NIC) and its associated Windows driver 

installed (the NIC and driver are standard on most computers).

• BOOTP/DHCP utility, such as the one that ships on the RSLogix 5000 programming 
software CD.

• An Ethernet Address (MAC) for each device. You recorded these addresses in the 
Network Worksheeton the back cover.

• An IP Address for each device. If you are on an non-isolated network, obtain these 
addressed from your network administrator. If you are on an isolated network, 
determine a numbering convention for your IP addresses. Record these addresses in the 
Network Worksheet on the backcover.

• You do not need to assign an IP address to the PanelView Plus terminal, it was already 
assigned in Chapter 6.
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Follow These Steps

If you have an EtherNet/IP network, complete these steps.

Terminology

Ethernet networks use these types of addresses:

Term Definition

Ethernet Address Each Ethernet device has a unique Ethernet address (sometimes called a MAC address). The 
address appears as twelve digits separated by colons (for example, xx:xx:xx:xx:xx:xx). It is 
usually on a label on the device itself. 

Each digit is a number in hexadecimal (0 to 9 or A to F). No other device in the world will have 
the same address, and it can not be changed.

You use the Ethernet address to identify a device so you can assign it an IP address.

IP Address In addition to the Ethernet address, an IP address identifies a node on an Ethernet network. 
The IP address can be manually set. or you can use special software to automatically assign it.

An IP Address consists of four decimal integers separated by periods (xxx.xxx.xxx.xxx). Each xxx 
is a decimal value from 0 to 255. For example, an IP Address could be 192.168.0.1. The 
selection of IP Addresses is beyond the scope of this quick start, so please contact your 
network administrator or use the ones provided in the examples.

Once you set an IP address for a device, you generally reference the device by its IP address. 
The examples in this quick start use IP Addresses to define communication paths to the 
devices.

Assign IP Addresses 
to Devices

Browse the 
EtherNet/IP 

Network in RSLinx

page 83

page 85
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Assign IP Addresses to Devices

This step assigns IP addresses to all of the devices in your system, except for the PanelView 
Plus terminal. The IP address for the PanelView Plus terminal was assigned during 
installation (see Chapter 6).

1. Launch the BOOTP/DHCP Server utility.

The BOOTP/DHCP Server utility is used to assign IP addresses to most 
of the devices in this quick start.

2. From the Tools menu, choose Network 
Settings.

3. Enter the Subnet Mask from the 
Network Worksheet.

4. Click OK.

The Request History displays all the devices on your network that need IP 
addresses. The Ethernet address (MAC) corresponds with the addresses 
recorded on Network Worksheet.

TIP Devices on the EtherNet/IP network broadcast requests for IP addresses until the IP addresses 
have been assigned.

The procedure in this chapter uses the BOOTP Server packaged with RSLogix 5000 programming 
software to assign IP addresses, however, any industry-standard BootP server will work.
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5. Double-click a request 
from one of the devices.

6. Enter the corresponding 
IP address that you 
selected from the 
Network Worksheet.

If you are not using an 
isolated network,
obtain these numbers 
from your network 
administrator.

7. Repeat steps 5 and 6 for 
all devices, except the 
PanelView Plus terminal 
(the IP address for the 
PanelView Plus terminal 
was set in Chapter 6).

If a device is power 
cycled, it will not retain its 
IP address unless you 
disable BOOTP/DHCP.

8. Select the first device in the Relation List and click Disable BOOTP/DHCP.

[Disable BOOTP/DHCP] Command successful appears in the Status bar.

9. Repeat step 8 for all devices, except the PanelView Plus.

10. Close the BOOTP/DHCP Server utility. 

If you are prompted to save changes, click No.
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Browse the EtherNet/IP Network in RSLinx

Additional Resources

Click the RSWho button to view the EtherNet/IP driver and devices.

Resource Description

EtherNet/IP Modules in Logix5000 Control 
Systems, publication ENET-UM001

Provides details regarding the installation, configuration, and operation of EtherNet/IP 
modules.

Tech Note # E47839422 available at: 
http://www.rockwellautomation.com/knowled
gebase/

Provides a description of a common Comms error dialog and its solution.
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Notes:
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Chapter 8

Configure the ControlNet Driver

In this chapter, you configure the ControlNet driver for your computer so you can program 
over a ControlNet network.

Before You Begin

• Prepare the computer, see Chapter 2.

• Install all hardware, see Chapters 1-6.

• Connect the computer, controller and all other ControlNet devices to a ControlNet 
network. This example uses BNC coaxial connectors to connect the taps and a 
terminating resistor at each end.

• Verify that power is applied to all devices.

What You Need

• RSNetWorx for ControlNet

• A 1784-PCIC or 1784-PCICS card and associated driver installed on your computer

Follow These Steps

If you have a ControlNet network, complete this step.

Configure the 
ControlNet Driver in 

RSLinx

page 88
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Configure the ControlNet Driver in RSLinx

RSLinx software

1. Launch RSLinx software.

2. From the 
Communications menu, 
choose Configure Drivers.

3. From the Available Driver 
Types pull-down 
menu, choose 
1784-PCIC(S) for 
ControlNet devices.

4. Click Add New.

5. Click OK to keep the default 
name.
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6. Enter an available ControlNet 
node address for the PCIC card.

This example uses node 
addresses between 1 and 10 
because it is a small ControlNet 
Network.

7. Click OK.

The ControlNet driver is added to the Configured Drivers list.

8. Verify that the driver’s Status is Running, and click Close.
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Additional Resources

Resource Description

ControlNet Modules in Logix5000 Control 
Systems, publication CNET-UM001

Provides details regarding the installation, configuration, and operation of ControlNet 
modules.

9. Click RSWho to view the driver.

10. Expand the driver to view the devices on your ControlNet network.

The PanelView Plus terminal does not appear because you have not set the 
node address yet. The node address is set in Chapter 14.
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Chapter 9

Configure the DeviceNet Network

In this chapter, you configure the DeviceNet node address for the 1769-SDN module. You 
also create the RSNetWorx for DeviceNet file that stores network configuration.

Before You Begin

• Prepare the computer, see Chapter 2.

• Install all hardware, see Chapters 1–6.

• Connect the 1769-SDN module, the 1734-ADN adapter and the PowerFlex drives to a 
DeviceNet network.
This example uses KwikLink right-angle male cables with sealed micro connectors 
connected to flat cable with terminator/resistors on each end.

• Verify that power is applied to all devices.

What You Need

• Power supply and tap for the DeviceNet network.
This example uses the 1606-XLDNET8 and a KwikLink power tap module.

• RSNetWorx for DeviceNet software.
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Follow These Steps

If you have a DeviceNet network, complete these steps.

Apply Power to the 
DeviceNet Network

Set the 1769-SDN 
Module’s Node 

Address

Create a DeviceNet 
Configuration File

page 93

page 94

page 96
92 Publication IASIMP-QS001C-EN-P - October 2009



Configure the DeviceNet Network         Chapter 9
Apply Power to the DeviceNet Network

1606-XLDNET8 power supply

Input
AC 100-120/200-240V   N   L
Isolate power before disconnecting

1606-XL POWER SUPPLY

DC ok

Output200W Limited Power
DC 24V / 8A
  +   –
                               DC ok

AC 120V

AC 240V

1. Connect incoming power to the 
power supply.

2. Place the switch in the position that 
matches your supply voltage.

3. Connect the DeviceNet power tap 
to the power supply.

For this example, there is no need to connect the DC ok relay on the power supply to 
anything.

4. If you have unused DeviceNet wires, make sure they do not come into contact with 
the other wires.

5. Connect the DeviceNet power tap to the DeviceNet network.

6. Turn on incoming power.

WARNING Verify that all incoming 
power is turned off before 
wiring power.

Connect To

V AC COM N (neutral)

120/240V AC L (line)

Ground

Connect To

Red +

White N/A

Shield N/A

Blue N/A

Black –
Publication IASIMP-QS001C-EN-P - October 2009 93



Chapter 9        Configure the DeviceNet Network
Set the 1769-SDN Module’s Node Address
1. Launch RSNetWorx for DeviceNet software.

2. From the Tools menu, choose Node 
Commissioning.

3. Click Browse.

4. Under AB_DF1-1, expand 
the CompactLogix Backplane 
and the 1769 Bus.

5. Expand the 1769-SDN and 
the DeviceNet Port, and select 
the 1769-SDN.

6. Click OK.
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The Node Commissioning 
dialog is populated with the 
1769-SDN module’s current 
settings.

8. Select 1 for the node Address 
of the 1769-SDN and click 
Apply.

The Address is applied and is 
confirmed in the Messages box.

9. Record the node address on the 
Network Worksheet.

10. Click Close.

7. If you receive a linking device 
warning, click Yes.
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Create a DeviceNet Configuration File

1. From the File menu, select 
New.

2. Select DeviceNet Configuration and 
click OK.

3. Click Who Active to go online.

4. Under AB_DF1-1, expand the 
CompactLogix Backplane and the 
1769 Bus.

5. Expand the 1769-SDN and the 
DeviceNet Port.

6. Record the 1769-SDN module’s slot 
number on the Network Worksheet.

In this example, the 1769-SDN 
module is in slot 6 of the 1769 Bus and 
is in node 1 on the DeviceNet 
network.

7. Select Port2, DeviceNet and click OK.

slot 6

node 1
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8. Click OK.

RSNetWorx software begins browsing the 
network.

If your PowerFlex drive does not display, see 
Uploading an EDS File From a Drive, 
Knowledgebase ID 20539.

TIP Once all of the devices on your 
DeviceNet network appear, you 
can click Cancel.

9. Right-click the 1769-SDN module and 
choose Properties.

10. Click the Module tab.

11. Click Download.

This clears all configuration from 
the 1769-SDN module, synching 
the software with the device.
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Additional Resources

Resource Description

DeviceNet Modules in Logix5000 Control 
Systems, publication DNET-UM004

Provides details regarding the installation, configuration, and operation of DeviceNet 
modules.

Uploading an EDS File From a Drive, 
Knowledgebase ID 20539, 
http://www.rockwellautomation.com/knowled
gebase/

Provides an explanation about uploading EDS files from drives.

12. From the Platform pull-down 
menu, select CompactLogix.

14. Click OK.

15. Save the file and record the file 
name and path on the Network 
Worksheet.

This quick start uses the example file 
name MainDNet.dnt.

16. Close RSNetWorx for DeviceNet 
software.

13. Enter the slot number of the 
1769-SDN you recorded on the 
Network Worksheet.
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Chapter 10

Create a Project Using RSLogix 5000 Programming 
Software

In this chapter you create a project in RSLogix 5000 programming software. In the project 
you use ladder logic to create a push button that controls a light on a digital output module. 
This project is used in subsequent chapters to test communication with other devices.

Before You Begin

• Configure your network:

– for an EtherNet/IP network, see Chapter 7

– for a ControlNet network, see Chapter 8

– for a DeviceNet network, see Chapter 9

What You Need

• A CompactLogix I/O module with digital outputs, this example uses a 1769-OB16.

• This example includes the following modules as well, but they are not required: 
1769-IF4, 1769-IQ16, 1769-IF4XOF2, 1769-OF2.
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Follow These Steps

Complete these steps.

Create a Project

Configure the 
Controller

Add Local I/O 
Modules

Add Ladder Logic to 
Test the Local 1769 

Compact I/O Modules

Set the 
Communication Path 

and Download to 
the Controller

Add the 1769-SDN 
to the Project

page 101

page 103

page 105

page 106

page 109

page 111

Optional
Complete if you have 
distributed I/O on the DeviceNet 
network.
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Create a Project

All controllers

2. Click New Project.

1. Double-click the RSLogix 5000 programming software icon to launch the 
software.

The Quick Start window displays in the RSLogix workspace.

Navigation tabs for 
Quick Start, Learning 
Center, and Resource 
Center pages.

The Quick Start pages provide useful links, tutorials, 
and tools you may choose to use at a later time.
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3. Choose your controller and 
revision number.EtherNet/IP

ControlNet 4. Enter a unique 
controller name.

5. Click OK.Serial
102 
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Configure the Controller

1769-L32E or 1769-L35E controllers

1. Expand the I/O Configuration 
tree.

2. Right-click the Ethernet Port 
and select Properties.

3. Enter the controller’s IP address 
(recorded on the Network 
Worksheet) and click OK.
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1769-L32C or 1769-L35CR controllers

1769-L31 controller

No further configuration is needed as the default properties are sufficient for the examples in 
this quick start.

1. Expand the I/O Configuration 
tree.

2. Right-click the ControlNet Port 
and select Properties.

3. In the Node box, enter the 
controller’s node address and 
click OK.
104 
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Add Local I/O Modules

All controllers

1. Right-click CompactBus Local and 
select New Module.

2. Select the leftmost 
I/O module in the 
1769 CompactLogix 
chassis and assign a 
slot number, then 
click OK.

3. In the Name box, 
type a name and 
click OK.

The module is added to the I/O 
Configuration.

4. Repeat steps 1–3 until all of your local I/O 
modules are added in order from left to 
right.

Do not add the 1769-SDN module. It is 
added on page 111.
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Add Ladder Logic to Test the Local 1769 Compact I/O Modules

All controllers

1. Expand the Tasks folders and 
double-click MainRoutine.

A blank MainRoutine opens.

2. From the Element Toolbar, drag and drop an Examine On and an 
Output Energize element onto the rung.
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3. Double-click the ? in the 
Examine On.

4. Type PB (for push button).

5. Press Enter.

6. Right-click PB and select New 
‘PB’.

7. Click OK to keep the 
defaults.
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9. Right-click the xxxx_Light tag name and 
select New ‘xxxx_Light’.

xxxx_Light is an alias tag for the I/O 
point tag name. This lets you assign a 
simple name to a physical I/O point 
address.

10. From the Type pull-down menu, 
select Alias.

11. In the Alias For pull-down menu, 
browse to a local 1769 digital output 
module and select any bit.

In this example, Local:5:O.Data.0 is 
used.

12. Click OK.

8. Name the Output Energize xxxx_Light (where xxxx is 
the suffix of the catalog number of the 1769 Compact I/O 
digital output module).

Important: Do not use spaces in the tag name. Use 
underscores (_) instead.
108 
Publication IASIMP-QS001C-EN-P - October 2009



Create a Project Using RSLogix 5000 Programming Software         Chapter 10
Set the Communication Path and Download to the Controller

All controllers

4. Expand the network tree.

5. Select your controller and 
click Set Project Path.

6. Click Download.

1. Save your changes.

3. Click Who Active.

EtherNet/IP

ControlNet

Serial

2. Move the keyswitch on your controller to Program.
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8. Move the keyswitch on your controller to Run.

9. Select the PB Examine On instruction and press Ctrl+T.

This toggles the state from 0 to 1 (off to on).

10. Verify that the LED indicator on the digital output module turns 
on.

11. Press Ctrl+T to toggle the state back to 0 (off).

12. Go Offline.

Off

On

The project Path updates.

EtherNet/IP

ControlNet

7. Click Download.

Serial
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Add the 1769-SDN to the Project

DeviceNet only

3. In the Name field, type a 
name for your SDN module.

4.  In the Slot field, enter the 
Slot number.

There can be a maximum of three modules between 
the 1769-SDN 
module and the power supply.

5. In the Input Size and Output Size fields, enter values to accommodate the input and 
output sizes of the modules in your system.

 This example uses 20.

For more information about determining input and output sizes, see the DeviceNet 
Modules in Logix5000 Control Systems User Manual, publication DNET-UM004.

6. From the Electronic Keying pull-down, choose Disable Keying.

7. Check the Open Module Properties check box and click OK.

1. Right-click CompactBus 
Local and select New 
Module.

2. Under Communications, 
select 1769-SDN with the 
series letter recorded on the 
Network Worksheet and click 
OK.
Publication IASIMP-QS001C-EN-P - October 2009 111

http://literature.rockwellautomation.com/idc/groups/literature/documents/um/dnet-um004_-en-p.pdf


Chapter 10        Create a Project Using RSLogix 5000 Programming Software
Additional Resources

Resource Description

Logix5000 Controllers Common Procedures 
Programming Manual, publication 1756-PM001

Provides details about creating and editing a program, communicating with modules, 
and configuring modules.

DeviceNet Modules in Logix5000 Control 
Systems, publication DNET-UM004

Provides details regarding the installation, configuration, and operation of DeviceNet 
modules.

9. Click OK.

The module is added to the 
I/O Configuration.

8. On the RSNetWorx tab, 
click Browse to find the 
configuration (.dnt) file 
recorded on the Network 
Worksheet.

Use the configuration file 
name you saved on 
page 98. This quick start 
uses MainDNet.dnt.
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Chapter 11

Add Distributed I/O Modules to the Project

In this chapter, you add distributed POINT I/O modules to your project using RSLogix 5000 
programming software. You also add ladder logic and download the project to the controller 
so you can test communication with an I/O module. This project builds upon the program 
created in Chapter 10.

Before You Begin

• Prepare the POINT I/O hardware, see Chapter 3

• Create a project in RSLogix 5000 programming software, see Chapter 10

What You Need

• A POINT I/O module with digital outputs, this example uses a 1734-OB4E

• This example includes the following modules as well, but they are not required: 
1734-IB4, 1734-OE2C

• For an EtherNet/IP network, no additional software is required

• For a ControlNet network, RSNetWorx for ControlNet software

• For a DeviceNet network, RSNetWorx for DeviceNet software
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Follow These Steps

If you have distributed POINT I/O modules, complete these steps for your network.

EtherNet/IP ControlNet DeviceNet

Add Distributed 
I/O Modules

page 115

Add Ladder Logic

page 127

Download the 
Project

page 134

Test the 
Distributed I/O 

Light

page 141

Add Distributed 
I/O Modules

page 115

Add Ladder Logic

page 127

Download the 
Project

page 134

Schedule the 
ControlNet 
Network

page 137

Test the 
Distributed I/O 

Light

page 141

Edit the DeviceNet 
Adapter 

Parameters
page 118

Create DeviceNet 
Tags and Add 
Ladder Logic

page 134

Create a 
DeviceNet 

Scanlist

page 141

Test the 
Distributed I/O 

Light

Configure the 
DeviceNet Subnet

page 120

page 124

page 129

Download the 
Project

Set the POINT I/O 
Chassis Size

page 135

Set the POINT I/O 
Chassis Size

page 135
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Add Distributed I/O Modules

EtherNet/IP and ControlNet only 
(for DeviceNet, skip to page 120)

3. Select the 1734 POINT I/O 
network adapter and click OK.

1. Verify that your project is 
Offline.

2. Right-click the network port 
and select New Module.

EtherNet/IP

ControlNet

EtherNet/IP

ControlNet

For an EtherNet/IP 
network, select a 
1734-AENT adapter.

For a ControlNet 
network, select a 
1734-ACNR adapter.
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7. Choose Disable Keying.

8. Uncheck the Open Module 
Properties checkbox and click 
OK.

The adapter is added to the 
I/O configuration.

9. Right-click the 1734 POINT 
network adapter module and 
select New Module.

4. Type a name for the 
adapter.

5. For an EtherNet/IP 
network, type the IP 
address.

For a ControlNet 
network, enter the 
adapter’s node 
number.

Use the Network 
Worksheet located 
inside the back cover 
as a reference.

6. Select the Chassis 
Size (exact number 
of POINT I/O 
modules + 1 for the 
adapter).

EtherNet/IP

ControlNet

EtherNet/IP

ControlNet
116 Pu
blication IASIMP-QS001C-EN-P - October 2009



Add Distributed I/O Modules to the Project         Chapter 11
11. Enter a name.

12. Click OK.

The module is added to the 
I/O Configuration.

13. Repeat steps 9–12 until all 
of your distributed I/O 
modules are added in order 
from left to right.

10. Select the left-most 
POINT I/O module 
in your chassis and 
click OK.

ControlNet 
Shown

If you have added more than one digital output module, select the one you want to test 
in this project and record the name and slot number on page 128.

Go to Add Ladder Logic on page 127.

14. Record the adapter name and digital output 
module slot number on page 128.
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Edit the DeviceNet Adapter Parameters

DeviceNet only
1. Launch RSNetWorx for DeviceNet. 

2. Open the main DeviceNet 
configuration file you saved and 
recorded on the Network Worksheet.

3. Click Who Active to go online.

4. If prompted, click OK.

5. Right-click the adapter and select 
Properties.

6. Select the Parameters tab.

7. Click Upload.
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8. Set the AutoAddress 
Backplane parameter to 1.

9. Set the Auto Start Mode 
parameter to Map Data to 
DWord Boundaries.

10. Click Apply, then clickYes.

11. Click OK.

12. Click Save.
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Configure the DeviceNet Subnet 

DeviceNet only

1. In RSNetWorx for DeviceNet, 
from the File menu, select New.

2. Select the DeviceNet 
Configuration file type.

3. Click OK.

4. Click Who Active to go online.

5. Expand the AB_DF1-1, DF1 
network and select the DeviceNet 
Subnet, DeviceNet network.

6. Click OK.
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7. Click OK.

The modules on 
the subnet display.

8. From the 
Network menu, choose Upload from 
Network.

9. Click Yes.

10. Right-click the scanner and select 
Properties. 
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11. Click the Device Bridging tab. 

12. Click Associate File.

13. Select the main DeviceNet configuration file 
you recorded on the Network Worksheet.

14. Click Open.

15. Click OK.

16. Save the DeviceNet subnet configuration 
file.

Name the file so it can be easily 
identified as the subnet. This quick 
start uses the name SubnetDNet.dnt.

17. Record the file name on the 
Network Worksheet located inside 
the back cover of this quick start.

18.  In RSNetWorx software, from the 
File menu, choose Open.
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19. Select your main DeviceNet file and 
click Open.

20. Right-click the POINT I/O adapter 
and select Properties.

21. Click the Device Bridging tab.

22. Click Associate File.

23. Select the subnet configuration file 
you recorded on the Network 
Worksheet and click Open.

24. Click OK.

25. Save your main DeviceNet 
configuration file.
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Create a DeviceNet Scanlist

Go Online. DeviceNet only
(for EtherNet/IP and ControlNet, skip to page 127)

1. Select Network > Upload from 
Network.

2. Click Yes.

3. Right-click the 1734-ADN adapter 
and select Properties.

4. Click the Parameters tab and write 
down the parameters shown.

5. Click OK.

6. Right-click the 1769-SDN module 
and select Properties.
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7. Click the Scanlist tab.

8. Click Upload.

The configuration is uploaded from the device.

9. Click the All Records radio button. 

10. Click Upload.

11. Select the 1734-ADN adapter and move it to the 
Scanlist.

12. Click Edit I/O Parameters.

13. Verify that the I/O parameters match step 4; if 
not, update them.

14. Click OK. 
Publication IASIMP-QS001C-EN-P - October 2009 125



Chapter 11        Add Distributed I/O Modules to the Project
15. Verify that Automap on Add is checked 
and click Apply.

16. Click Yes.

Click OK.

17. Save the configuration file.

You will use this file to Create DeviceNet 
Tags and Add Ladder Logic later in this 
chapter.

18. Close RSNetworx for DeviceNet software.
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Add Ladder Logic

EtherNet/IP and ControlNet only
(for a DeviceNet, go to page 129)

1. In RSLogix 5000 programming software, drag and drop a Branch onto the rung.

2. Expand the branch to the right side of the xxxx_Light.

3. Drag and drop another Output Energize element 
onto the Branch and name it xxxx_Light 
(where xxxx is the suffix of the catalog number of 
the digital 1734 POINT output module).
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5. From the Type pull-down, 
choose Alias.

6. From the Alias For pull-down 
menu, browse to find the 
addresses recorded below.

7. Click OK.

Go to page 134 to Download the Project.

For Select This Address Example From

EtherNet/IP _______:O.Data[__].__ my_AENT:O.Data[2].0 Step 14 on page 117

ControlNet _______:O.Data[__].__ My_ACNR:O.Data[2].0 Step 14 on page 117

adapter
name

output
module 
slot #

any
bit

adapter
name

output
module 
slot #

any
bit

4. Right-click the Light and select 
New ‘xxxx_Light’.

EtherNet/IP 
shown
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Create DeviceNet Tags and Add Ladder Logic

DeviceNet network only

1. In RSLogix 5000 programming software, from the 
Tools menu, choose DeviceNet Tag Generator.

2. Select your RSLogix 5000 project.

3. Click Select Scanner.

4. Select the 1769-SDN 
scanner that scans the network 
where the drive is located.

5. Click Select RSNetWorx Project.

6. Select main DeviceNet configuration file 
recorded on the Network Worksheet.

7. Click Select Scanner Node.

IMPORTANT Before running the DeviceNet Tag Generator, verify that 
RSNetWorx for DeviceNet software is closed.
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8. Select the node of the 1769-SDN scanner 
as recorded on the Network Worksheet.

9. Click Generate Tags.

10. Click Generate Tags.

11. Click Yes.

When tag generation is 
complete, the text log displays.

12. Close the DeviceNet Tag Generator.

Note that new programs and tags 
have been added to the controller 
organizer. These tasks were created by the 
Tag Generator.

13. In the controller organizer, select 
MainProgram > MainRoutine.
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14. Drag and drop a Branch 
instruction into the first rung.

15. Expand tthe Branch to the right side of the xxxx_Light.

16. Drag and drop another Output Energize element onto 
the Branch and name it xxxx_Light (where xxxx is 
the suffix of the catalog number of the digital 1734 
POINT output module).

17. Right-click the Light and select New 
‘xxxx_Light’.
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Node Number Slot Number Tag Type

18. From the Type pull-down menu, 
choose Alias.

19. From the Alias For pull-down menu, 
browse to find SDN output data tags.

20. Select the output data tag that 
corresponds to the LED indicator you 
want to turn on.

Use this diagram as a reference when 
selecting your output tag.

For example, selecting 
the tag that ends with 
O.Data.0 will turn on light 0 of 
the output module.

21. Click OK.

Connection TypeSDN Module Name Channel
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22. Add another Rung with an Output Energize 
element.

23. Double-click the ? and select the 
tag 
Local:X:O.CommandRegister.Ru
n where X is the slot of the 
1769-SDN module (recorded on 
the Network Worksheet).

Programming this 
bit changes the 
1769-SDN module 
from IDLE mode 
to Run mode.
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Download the Project

EtherNet/IP, ControlNet, and DeviceNet 

1. Save your changes.

4. Click Download.

If you have no loads wired to 
your distributed output modules, 
the red status LEDs indicators 
may start blinking.

3. Click the Controller Status icon 
and select Download.

If you are using ControlNet or EtherNet networks, after you download to the 
controller, the 1734 modules show faults. Continue with Set the POINT I/O Chassis 
Size on page 135.

If you are using DeviceNet, skip to Test the Distributed I/O Light on page 141.

2. Move the keyswitch on your controller to Program.
134 
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Set the POINT I/O Chassis Size

ControlNet and EtherNet
(DeviceNet networks, skip to page 141)

1. Right-click the 1734-ACNR/AENT and 
select Properties.

2. Click the Chassis Size tab.

If the chassis sizes match, skip to step 1 on 
page 137.

If the numbers do not match, 
take the following action.

3. On the Connection tab, check 
the Inhibit Module 
checkbox and click Apply.

4. Click Yes.

5. On the Chassis size tab, 
click Set Chassis Size in Module.

6. Click OK at the warning.

The Module chassis size 
updates.
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7. On the Connection Tab, uncheck 
the Inhibit Module checkbox 
and click OK.

8. Click Yes.

You have set the POINT I/O 
chassis size.

9. Click Save.

For ControlNet, go to Schedule the ControlNet Network on page 137.

For EtherNet, skip to Test the Distributed I/O Light on page 141.
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Schedule the ControlNet Network

ControlNet only
(For EtherNet or DeviceNet, skip to page 141.)

1. Right-click the ControlNet Port 
and select Properties.

2. On the RSNetWorx tab, enter a 
new ControlNet file name and 
click Apply.

3. Click Yes.

4. Click Yes.
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7. Verify that Use offline 
data (download) is 
selected and click OK.

RSNetWorx browses the 
network.

8. If prompted, select 
Optimize and click OK.

RSNetWorx for 
ControlNet software 
browses the network again.

5. Select Schedule the 
ControlNet network.

6. Click the RSNetWorx 
icon.

RSNetWorx for 
ControlNet launches.
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9. Check the Edits Enabled 
checkbox.

10. From the Network menu, 
choose Properties.

11. In the Pending column, select 
a Max Scheduled Address 
and Max Unscheduled 
Address that are equal to the 
largest node addresses in your 
system.

This example uses 6.

12. Click OK.
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13. Save your changes.

14. Click OK.

15. Click Yes.

RSNetWorx for 
ControlNet software 
browses the network 
again. This time fewer node 
addresses are browsed because 
of the smaller Max 
Unscheduled Address.
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Test the Distributed I/O Light

EtherNet/IP, ControlNet, and DeviceNet

1. Move the keyswitch on your controller to RUN.

2. Select the PB and press Ctrl+T.

This toggles the state from 0 to 1 (off to on).

3. Verify that the light on both the local and distributed digital 
output modules turn on.

4. Press Ctrl+T to toggle the state back to 0 (off).

5. Select Go Offline.

Off

On

ControlNet 
Shown
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Additional Resources

Resource Description

ControlLogix Controllers Common Procedures 
Programming Manual, publication 1756-PM001

Provides details about adding and configuring modules, establishing communication, 
and writing ladder logic. 

DeviceNet Modules in Logix5000 Control 
Systems, publication DNET-UM004

Provides details about creating scanlists as well as other DeviceNet-specific 
application information.

ControlNet Modules in Logix5000 Control 
Systems, publication CNET-UM001

Provides details about configuring and scheduling the ControlNet modules.
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Chapter 12

Create a PowerFlex 70 Application

In this chapter, you configure a PowerFlex 70 drive and add the drive to the RSLogix 5000 
project created in Chapter 10. You also download the project to the controller so you can test 
communication with the drive. 

Before You Begin

• Prepare the PowerFlex 70 drive and network adapter, see Chapter 4

• Create a project using RSLogix 5000 programming software, see Chapter 10

What You Need

• For an EtherNet/IP network, no additional software is needed

• For a ControlNet network, RSNetWorx for ControlNet software

• For a DeviceNet network, RSNetWorx for DeviceNet software
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Follow These Steps

If you have a PowerFlex 70 drive, complete these steps for your network:

EtherNet/IP ControlNet DeviceNet

Add the Drive to 
Your RSLogix 5000 

Project and 
Connect to the 

Drive
page 145

Edit the Drive 
Parameters

page 149

Download the 
Project

page 156

Schedule the 
ControlNet 
Network

page 157

Test the PowerFlex 
70 Tags

page 161

Add the Drive to 
Your RSLogix 5000 

Project and 
Connect to the 

Drive
page 145

Edit the Drive 
Parameters

page 149

Download the 
Project

page 156

Test the PowerFlex 
70 Tags

page 161

Create a 
DeviceNet 

Scanlist
page 150

Create DeviceNet 
Tags

page 154

Download the 
Project

page 156

Test the PowerFlex 
70 Tags

page 163

Schedule the 
ControlNet 
Network

page 157
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Add the Drive to Your RSLogix 5000 Project and Connect to the Drive

Ethernet/IP and ControlNet only
(for a DeviceNet, skip to page 150)

1. Move the controller 
keyswitch to PROG and go 
offline.

2. In the RSLogix 5000 
programming software, 
right-click the controller 
network port and select 
New Module.

3. Expand Drives.

4. Select the PowerFlex 
70-x and click OK.

EtherNet/IP

ControlNet

EtherNet/IP

ControlNet
145
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5. Enter a Name and IP 
Address 
(EtherNet/IP) or 
Node number 
(ControlNet). 

6. Click Change...

7. On the Module 
Definition dialog box, 
click Match Drive.

8. On the Full or Partial 
Match dialog box, make 
sure the Include I/O 
box is unchecked and 
click Partial.

9. Click OK.

The PowerFlex 70 is 
added to the controller 
organizer under the 
network port.

10. Click Save.

11. Download and put the 
controller in Remote 
Run mode.

EtherNet/IP

ControlNet

ControlNet

EtherNet/IP

EtherNet/IP
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EtherNet/IP

12. Right-click the PowerFlex 
70 drive and select 
Properties.

13. Click the Drive tab.

14. Click Connect to Drive.

15. Select the PowerFlex 70 
drive and click OK.

16. Click Download.

ControlNet
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A drive database is created.

After the download and 
drive database creation is 
complete, the drive status 
will change to connected.

Once the drive is connected, 
go to Edit the Drive 
Parameters on page 149.
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Edit the Drive Parameters

EtherNet/IP and ControlNet only
(for a DeviceNet, skip to page 150)

1. In the drive organizer, double-click 
Parameter List.

2. Enter the following parameters:

3. Click OK.

The parameters are loaded to the drive.

  Parameter   Name   Value

Parameter 61 Autotune Ready

Parameter 90 Speed Ref A Sel DPI Port 5

Parameter 361 Digital In1 Sel Not Used

Parameter 362 Digital In2 Sel Not Used

Parameter 363 Digital In3 Sel Not Used

Parameter 364 Digital In4 Sel Not Used

Parameter 365 Digital In5 Sel Not Used

Parameter 366 Digital In6 Sel Not Used

4. Close the PowerFlex 70 Properties dialog.

If you are using a EtherNet network, go to Test the PowerFlex 70 Tags on page 161.

If you are using ControlNet, go to Schedule the ControlNet Network on page 157.
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Create a DeviceNet Scanlist

DeviceNet only

1. Move the controller keyswitch to 
PROG and go offline.

2. In RSLogix controller organizer, 
right-click the 1769-SDN and select 
Properties.

3. On the RSNetWorx tab, click 
the RSNetWorx icon.

4. In RSNetWorx for 
DeviceNet, click Who Active to go 
online.

5. Click OK.

If the drive does not display or 
displays with an error regarding the 
EDS file, see Knowledgebase article 
20539.

6. Right-click the PowerFlex 70 drive and 
select Download to Device.

7. Click Yes.

The configuration is downloaded to 
the PowerFlex 70 drive.
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8. Right-click the PowerFlex 70 
drive and select Properties.

9. Select the Parameters tab.

10. Change 61, Autotune, to 
Ready.

11. Change 90, Speed Ref A Sel, to 
DPI Port 5.

Setting this parameter 
configures drive to use the 
speed reference from the 
network.

12. Click OK.
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The configuration is 
downloaded to the PowerFlex 
70 drive.

14. Right-click the 1769-SDN 
scanner and select 
Properties.

15. Select the Scanlist tab.

16. Click Upload.

The configuration is 
uploaded from the 
1769-SDN scanner.

13. Click Yes.
1
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17. Select the PowerFlex 70 drive and 
move it to the Scanlist.

18. Verify that Automap on Add is 
checked and click Apply.

19. Click Yes to download.

20. Save your file.

21. Close RSNetWorx for DeviceNet.
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Create DeviceNet Tags

DeviceNet only

1. Switch the controller to Program Mode.

2. In RSLogix 5000 programming software, from the 
Tools menu, choose DeviceNet Tag Generator.

3. Select the RSLogix 5000 project you are creating 
tags for.

4. Click Select Scanner.

5. Select the 1769-SDN scanner that 
scans the network where the drive is 
located.

6. Click Select RSNetWorx Project.

7. Select DeviceNet configuration file 
recorded on the Network Worksheet.

8. Click Select Scanner Node.

IMPORTANT Before running the DeviceNet Tag Generator, verify that 
RSNetWorx for DeviceNet software is closed.
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9. Select the node of the 1769-SDN scanner 
as recorded on the Network Worksheet.

10. Click Generate Tags.

11. Click Generate Tags.

12. Click Yes.

When tag generation is complete, the text 
log displays.

13. Close the DeviceNet Tag Generator.
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Download the Project

DeviceNet only

TIP If you receive a fault message on your PowerFlex 70 drive display, press  
on the keypad to clear the fault.

2. Click the Controller 
Status icon and 
select Download.

3. Click Download.

The project 
downloads to the 
controller.

If you are using a DeviceNet network, go to Test the PowerFlex 70 Tags on page 
163.

1. If you have not already done so, move 
the keyswitch on your controller to 
PROG.
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Schedule the ControlNet Network

ControlNet only
(for Ethernet/IP, skip to page 161; for DeviceNet, skip to page 163)

1. Right-click the 
ControlNet Port and 
select Properties.

2. On the RSNetWorx tab, enter 
a new ControlNet file name and 
click Apply.

3. Click Yes.

4. Click Yes.
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7. Verify that Use offline 
data (download) is 
selected and click OK.

RSNetWorx browses the 
network.

8. If prompted, select 
Optimize and click OK.

RSNetWorx browses the 
network again.

5. Select Schedule the 
ControlNet network.

6. Click the RSNetWorx icon.

RSNetWorx for ControlNet 
software launches.
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9. Check the Enable Edits 
checkbox.

10. From the Network menu, 
choose Properties.

11. In the Pending column, select 
a Max Scheduled Address 
and Max Unscheduled 
Address that are equal to the 
largest node addresses in your 
system.

12. Click OK.
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13. Save your changes.

14. Click OK.

15. Click Yes.

RSNetWorx browses the 
network again. This time 
fewer node addresses are 
browsed because of the 
smaller Max Unscheduled 
Address.
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Test the PowerFlex 70 Tags

Ethernet/IP and ControlNet only (for DeviceNet, skip to page 163) 

2. Double-click Controller Tags.

3. Locate and 
expand the 
PowerFlex 70 
output tag.

4. Change the ClearFault tag to 1 to 
clear any initial faults.

5. Change the ClearFault tag back to 
0.

1. Move the controller keyswitch to RUN.

TIP To change a tag in RSLogix:
1. Select the tag value.
2. Enter or select the desired value.
3. Press Enter.
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8. Change the Start tag to 1.

The display on the drive registers the speed 
increase in Hz until the value entered at the 
reference tag is reached.

9. Change the Start tag back to 0.

10. Change the Stop tag to 1.

The display on the drive will show a speed 
decrease until the drive reaches 0.00 Hz.

11. Change the Stop tag from 1 to 0.

12. Go Offline.

6. Verify that the I.Ready tag value is 1.

This tag indicates that the drive is 
ready to start.

7. Change the O.CommandedFreq tag 
to 15000 engineering units (this is 
approximately 59.5 Hz).

WARNING
If there is a motor attached to your drive, 
completing the next step will cause it to turn.

EU
Hz
-------- 32767

130
---------------=

By starting and stopping the drive, you verified that:

• the controller is correctly communicating with the drive.

• the drive can receive simple commands.
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Test the PowerFlex 70 Tags

DeviceNet only

TIP To change a tag in RSLogix:
1. Select the tag value.
2. Enter or select the desired value.
3. Press Enter.

2. In the controller organizer, double-click 
Controller Tags.

If you have added distributed I/O to your 
project in Chapter 11, skip to step 4.

3. Change the tag 
O.CommandRegister.Run tag 
to 1.

This changes the 1769-SDN 
scanner to Run mode.

4. At the tag O.Reference, change 
the value to 15000 engineering 
units (this is approximately 59.5 
Hz).

This is the speed your drive will 
accelerate to and is determined 
using the equation shown.

1. Move the controller keyswitch to RUN.

EU
Hz
-------- 32767

130
---------------=

PowerFlex 70 tags are identified 
in the description column.
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5. Expand the output 
tags for the 
PowerFlex 70.

WARNING
If there is a motor attached to your drive, 
completing the next step will make it turn.

6. At the O.Start tag, enter 1.

The display on the drive registers the speed 
increase in Hz until the value entered at the 
reference tag is reached.

7. Change the Start tag back to 0.

8. Change the Stop tag to 1.

The display on the drive will show a speed 
decrease until the drive reaches 0.00 Hz.

9. Change the Stop tag back to 0.

10. Select Go Offline.
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By starting and stopping the drive, you verified that:

• The controller is correctly communicating with the drive.

• The drive can receive simple commands.

Additional Resources

Resource Topic

DeviceNet Modules in Logix5000 Control Systems, publication 
DNET-UM004

Describes common procedures and troubleshooting tasks related to 
DeviceNet networks.

Logix5000 Controllers Common Procedures Programming 
Manual, publication 1756-PM001

Provides details about adding and configuring modules, establishing 
communication, and writing ladder logic.

PowerFlex 70 Adjustable Frequency AC Drive User Manual, 
publication 20A-UM001

Provides information about installing, programming, editing 
parameters, and troubleshooting the PowerFlex 70 drive.

PowerFlex 70 EtherNet/IP Adapter User Manual, publication 
20COMM-UM010

Provides process for installing, configuring, and troubleshooting the 
adapter.

PowerFlex 70 ControlNet Adapter User Manual, publication 
20COMM-UM003

Provides process for installing, configuring, and troubleshooting the 
adapter.

PowerFlex 70 DeviceNet Adapter User Manual, publication 
20COMM-UM002

Provides process for installing, configuring, and troubleshooting the 
adapter.

Knowledgebase article ID 20539 at 
http://support.rockwellautomation.com/

Provides details about uploading EDS files from the drive.
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Notes:
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Create a PowerFlex 40 Application

In this chapter, you configure a PowerFlex 40 drive using with the drive keypad and add the 
drive to your project using RSLogix 5000 programming software. You also download the 
project to the controller so you can test communication with the drive. This project builds 
upon the project created in Chapter 10.

Before You Begin

• Prepare the PowerFlex 40 drive and network adapter, see Chapter 5

• Create a project using RSLogix 5000 programming software, see Chapter 10

What You Need

• For an EtherNet/IP network, no additional software is needed

• For ControlNet, RSNetWorx for ControlNet software

• For DeviceNet, RSNetWorx for DeviceNet software
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Follow These Steps

If you have a PowerFlex 40 drive, complete these steps for your network.

EtherNet/IP ControlNet DeviceNet

Add the Drive to 
Your RSLogix 5000 

Project
page 169

Download the 
Project

page 176

Schedule the 
ControlNet 
Network

page 177

Edit PowerFlex 40 
Parameter Values

page 181

Test the PowerFlex 
40 Tags

page 181

Add the Drive to 
Your RSLogix 5000 

Project
page 169

Download the 
Project

page 176

Edit PowerFlex 40 
Parameter Values

page 181

Test the PowerFlex 
40 Tags

page 181

Create a 
DeviceNet 

Scanlist
page 171

Download the 
Project

page 176

Edit PowerFlex 40 
Parameter Values

page 181

Test the PowerFlex 
40 Tags

page 185

Create DeviceNet 
Tags

page 174
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Add the Drive to Your RSLogix 5000 Project

EtherNet/IP and ControlNet networks only
(for a DeviceNet network, skip to page 171)

1. Right-click your network 
port and select New 
Module.

2. Expand Drives.

3. Select the PowerFlex 40-x.

EtherNet/IP

ControlNet

EtherNet/IP

ControlNet
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7. On the Module Definition 
dialog box, click Match 
Drive.

8. On the Full or Partial Match 
dialog box, click Partial.

9. Click OK.

10. Click OK again.

The PowerFlex 40 is added to 
the controller organizer.

4. In the Name field, type a 
name for the drive.

5. Enter an IP Address 
(Ethernet network) or 
Node number 
(ControlNet network) for 
the PowerFlex 40 drive.

6. Click Change.

ControlNet

EtherNet/IP

ControlNet

EtherNet/IP

For EtherNet/IP and ControlNet, skip to Download the Project on page 176.
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Create a DeviceNet Scanlist

DeviceNet only

2. In the RSLogix 5000 programming 
software, right-click the 1769-SDN 
and select Properties.

3. If RSNetWorx for DeviceNet is open, 
skip to step 4.
If RSNetWorx for DeviceNet is 
not open:

a. In RSLogix 5000 
programming, right-click the 
1769-SDN and select 
Properties.

b. On the RSNetWorx tab, click the 
RSNetWorx button.

4. Click Who Active to go online.

5. Click OK.

6. Right-click the PowerFlex 40 and select 
Download to Device.

1. Move the controller keyswitch to PROG.
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7. Click Yes.

The configuration downloads to 
the PowerFlex 40.

8. Right-click the 1769-SDN and select 
Properties.

9. Click the Scanlist tab.

10. Click Upload.
172 Publication IASIMP-QS001C-EN-P - October 2009



Create a PowerFlex 40 Application         Chapter 13
11. Select the PowerFlex 40 drive 
and move it to the Scanlist.

12. Verify that Automap on Add 
is checked and click Apply.

13. Click Yes.

14. Click OK.

15. Save your file.

16. Close RSNetWorx for DeviceNet software.
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Create DeviceNet Tags

DeviceNet only
(to complete this step for EtherNet/IP or ControlNet, see page 169)

1. In RSLogix 5000 programming software, from the 
Tools menu, choose DeviceNet Tag Generator.

2. Select the RSLogix 5000 project.

3. Click Select 
Scanner.

4. Select the 1769-SDN scanner that 
scans the network where the drive is 
located.

5. Click Select RSNetWorx Project.

6. Select DeviceNet configuration file recorded on 
the Network Worksheet.

7. Click Select Scanner Node.

IMPORTANT Before running the DeviceNet Tag Generator, verify that 
RSNetWorx for DeviceNet software is closed.
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8. Select the node of the 1769-SDN module 
as recorded on the Network Worksheet.

9. Click Generate Tags.

10. Click Generate Tags.

11. Click Yes.

When tag generation is complete, the text 
log displays.

12. Close the DeviceNet Tag Generator.
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Download the Project

EtherNet/IP, ControlNet, and DeviceNet

TIP If you receive a fault message on your PowerFlex 40, press  on the keypad 
to clear the fault.

2. Click the Controller 
Status icon and select 
Download.

3. Click Download.

The project downloads to the 
controller.

If you are using EtherNet/IP or DeviceNet networks, skip to Edit PowerFlex 40 Parameter 
Values on page 181.

If you are using ControlNet continue with Schedule the ControlNet Network on page 177.

1. If you have not already done so, move 
the keyswitch on your controller to 
PROG.
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Schedule the ControlNet Network

ControlNet only
(for EtherNet/IP and DeviceNet, skip to page 181) 

1. Right-click the 
ControlNet Port and 
select Properties.

2. On the RSNetWorx tab, 
enter a new 
ControlNet file name 
and click Apply.

3. Click Yes.

4. Click Yes.
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7. Verify that Use offline data 
(download) is selected and 
click OK.

RSNetWorx browses the 
network.

8. If prompted, select 
Optimize and click OK.

RSNetWorx browses the 
network again.

9. Check the Edits Enabled 
checkbox.

5. Select Schedule the 
ControlNet network.

6. Click the RSNetWorx icon.

RSNetWorx for ControlNet 
launches.
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10. Select Network > Properties.

11. In the Pending column, select a 
Max Scheduled Address and 
Max Unscheduled Address that 
are equal to the largest node 
addresses in your system.

12. Click OK.

13. Save your changes.
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14. Click OK.

15. Click Yes.

RSNetWorx software 
browses the network 
again. This time fewer 
node addresses are 
browsed because of the 
smaller Max Unscheduled 
Address.
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Edit PowerFlex 40 Parameter Values

TIP Use the table below as a reference when editing parameter values as instructed on 
page 182. 

When power is first applied to the PowerFlex 40 drive, the display defaults to the 
current value.

Reference for Editing Parameters 

Step Displayed

1. Press .
The parameter number is displayed and blinks.

2. Press  to select the group letter.
The group letter blinks.

3. Press  or  to scroll through the group letters.

4. Press  to select the desired group letter.
The parameter number blinks.

5. Press  or  to scroll through the parameter numbers.

6. Press  to select the desired parameter number.
The parameter value is displayed.

7. Press  or  to scroll through the parameter values.
The values blink as you scroll through them.

8. Press  to select the desired parameter value.
The parameter stops blinking.

9. Press  to return to the parameter number.

10.Follow this procedure to change other parameter values, or 

press  repeatedly to return to the value display.

VOLTS
AMPS
HERTZ

FAULTPROGRAM

VOLTS
AMPS
HERTZ

FAULTPROGRAM

VOLTS
AMPS
HERTZ

FAULTPROGRAM

VOLTS
AMPS
HERTZ

FAULTPROGRAM

VOLTS
AMPS
HERTZ

FAULTPROGRAM

VOLTS
AMPS
HERTZ

FAULTPROGRAM

VOLTS
AMPS
HERTZ

FAULTPROGRAM

VOLTS
AMPS
HERTZ

FAULTPROGRAM
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EtherNet/IP, ControlNet, and DeviceNet

Use the reference on page 181 to make the following parameter value edits on your 
PowerFlex 40.

1. If your PowerFlex 40 has been previously used, reset it to factory defaults.

a. Change the value of parameter P041 from 0 to 1.

The drive is reset and fault F048 is displayed and blinks. 

b. Press  to clear the fault.

c. Press  to return to editing parameters.

2. Change the value of parameters P036 and P038 from 0 to 5.

Changing these parameters switch control the Start Source and the Speed Reference 
from the keypad to the communication port, giving you the ability to control these 
functions from the RSLogix 5000 tags.

3. Press  to accept parameter edits.

For EtherNet and ControlNet networks, go to Test the PowerFlex 40 Tags on page 183.

For a DeviceNet network, go to Test the PowerFlex 40 Tags on page 185.
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Test the PowerFlex 40 Tags

EtherNet/IP and ControlNet only
(for a DeviceNet network, skip to page 185)

2. Double-click Controller Tags.

3. Expand the 
PowerFlex 40 
output tag.

4. At the O.FreqCommand Tag, 
enter 555.

The value 555 equals 55.5 Hz.

1. Move the controller keyswitch 
to RUN.

TIP To change a tag in RSLogix:
1. Select the tag value.
2. Enter or select the desired value.
3. Press <Enter>.
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5. At the O.Start tag, enter 1.

The drive begins to run and the display will 
register the drive’s speed until it reaches 55.5 
Hz.

6. After the drive has reached 55.5 Hz, 
enter 0 at the O.Start tag.

7.  At the O.Stop tag, enter 1.

The drive begins to slow until reaching 0.0 Hz.

8. When the drive reaches 0.0 Hz, enter 0 at the 
O.Stop tag.

9. Select Go Offline.

By starting and stopping the drive, you verified that:

• the controller is correctly communicating with the drive.

• the drive can receive simple commands.

If you are using EtherNet/IP or ControlNet, you are done configuring the PowerFlex 40 
drive and you can continue with the next chapter; or see page 187 for more information.

WARNING
If there is a motor attached to your drive, completing the next 
step will cause it to turn.
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Test the PowerFlex 40 Tags

DeviceNet network only
(to complete this step on EtherNet/IP or ControlNet networks, see page 183)

TIP To change a tag in RSLogix:
1. Select the tag value.
2. Enter or select the desired value.
3. Press <Enter>.

2. In the configuration tree, double-click 
Controller Tags.

If you have added distributed I/O to your 
project in Chapter 11, skip to step 4.

3. Change the tag 
O.CommandRegister.Run tag 
to 1.

This changes the 1769-SDN to 
Run mode.

4. At the tag O.Reference, enter the value 
555.

The value 555 equals 55.5 Hz. This is the 
speed to which your drive will accelerate.

1. Move the controller keyswitch to RUN.

PowerFlex 40 tags are 
identified in the description 
column.
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5. Expand the 
PowerFlex 40 
output tag.

6. At the O.Start tag, enter 1.

WARNING
If there is a motor attached to your drive, completing the 
next step will make it turn.

The display on the drive registers the 
speed increase in Hz until the value 
entered at the reference tag is reached.

7. Change the O.Start tag back to 0.

8. Change the O.Stop tag to 1.

The display on the drive will show a 
speed decrease until the drive reaches 0.00 Hz.

9. Change the Stop tag back to 0.

10. Select Go Offline.
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By starting and stopping the drive, you verified:

• the controller is correctly communicating with the drive.

• the drive can receive simple commands.

Additional Resources

Resource Topic

DeviceNet Modules in Logix5000 Control Systems, publication 
DNET-UM004

Describes common procedures and troubleshooting tasks related to 
DeviceNet networks.

Logix5000 Controllers Common Procedures Programming 
Manual, publication 1756-PM001

Provides details about adding and configuring modules, establishing 
communication, and writing ladder logic.

PowerFlex 40 Adjustable Frequency AC Drive User Manual, 
publication 22B-UM001

Provides information about installing, programming, editing 
parameters, and troubleshooting the PowerFlex 70 drive.

PowerFlex 70 EtherNet/IP Adapter User Manual, publication 
22COMM-UM004

Provides process for installing, configuring, and troubleshooting the 
adapter.

PowerFlex 70 ControlNet Adapter User Manual, publication 
22COMM-UM006

Provides process for installing, configuring, and troubleshooting the 
adapter.

PowerFlex 70 DeviceNet Adapter User Manual, publication 
20COMM-UM003

Provides process for installing, configuring, and troubleshooting the 
adapter.
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Notes:
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Create a PanelView Plus Application

In Chapter 10, you used ladder logic in the RSLogix 5000 programming software to create a 
push button that controlled an LED indicator on a digital output module. In this chapter you 
create a push button and a multi-state indicator in FactoryTalkView software that use that 
ladder logic. You also transfer the application to the PanelView Plus so you can test 
communication with the controller.

Before You Begin

• Prepare the PanelView Plus, see Chapter 6

• Create a project in RSLogix 5000 programming software, see Chapter 10

What You Need

• FactoryTalkView Machine Edition software
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Follow These Steps

If you have a PanelView Plus terminal, complete these steps.

Create a New 
Application

Create an RSLinx 
Enterprise 

Configuration in 
FactoryTalkView ME

Create Device 
Shortcuts to the 

Controller

Create the 
OB16_Light 

Indicator

Create a Push 
Button

Test the Indicator 
and Push Button

page 191

page 192

page 194

page 200

page 203

page 205

Add a Goto 
Configuration Mode 

Button

page 207

Assign Keys

page 208

Assign an Initial 
Screen

page 209

Transfer to 
PanelView Plus 

page 210

Test the Application 
on the PanelView 
Plus Application

page 212
190 Publication IASIMP-QS001C-EN-P - October 2009



Create a PanelView Plus Application         Chapter 14
Create a New Application

All controllers 

2. Select the New tab.

1. Launch FactoryTalkView Studio software. 

3. In the Application Name 
field, type a name (do not use 
spaces) and click Create.
Publication IASIMP-QS001C-EN-P - October 2009 191



Chapter 14        Create a PanelView Plus Application
Create an RSLinx Enterprise Configuration in FactoryTalkView ME

All controllers

1. In the FactoryTalkView organizer, expand 
RSLinx Enterprise and double-click 
Communication Setup.

2. Click Finish.

RSLinx Enterprise opens.
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The Local tab defines the path from the computer to the controller.
The Target tab defines the path from the PanelView Plus terminal to the controller.

Computer Controller Terminal

TargetLocal

The computer needs to 
communicate with the 
controller when you are in 
Test Run mode. This path is 
defined on the Local tab.

The PanelView Plus terminal 
also needs to communicate 
with the controller, but that is 
sometimes a different path. 
This path is defined on the 
Target tab.
Publication IASIMP-QS001C-EN-P - October 2009 193



Chapter 14        Create a PanelView Plus Application
Create Device Shortcuts to the Controller

1769-L32E or 1769-L35E controllers
(for a 1769-L32C or 1769-L35CR controllers, skip to page 196;
for a 1769-L31 controller, skip to page 198) 

1. Expand the EtherNet/IP tree, select your controller and click Add.

2. Type a shortcut name (do not use spaces) and click Apply.

3. Click Copy from Design to Runtime button. 
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4.  Click Yes.

5.  Select the Target tab to view the path from the PanelView Plus terminal to the 
controller.

6. Click the shortcut to verify that your controller is highlighted.

7. Click OK.

8. Skip to page 200.
Publication IASIMP-QS001C-EN-P - October 2009 195



Chapter 14        Create a PanelView Plus Application
1769-L32C or 1769-L35CR controllers
(to complete this step on the 1769-L32E or 1769-L35E controllers, see page 194;
for a 1769-L31 controller, skip to page 198) 

1. Right-click RSLinx 
Enterprise and select 
Add Driver.

2. Select the 1784-PCIC(S) driver 
and click OK.

3. Define the properties for the 
ControlNet card.

a. Keep the default Name to 
represent the card in the 
computer.

b. Select an available 
ControlNet node Address 
for the card in the computer.

c. Select any Slot number other 
than 0 (which is reserved).
The slot number does not 
matter, so any number other 
than 0 works.

d. Click OK.

5. Expand the Backplane tree, select 
your controller and click Add.
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7. Change the Name to represent 
the ControlNet adapter on your 
PanelView Plus.

8. Assign an unused ControlNet 
node Address. to the ControlNet 
communication module on the 
PanelView Plus.

9. Change the Slot to 01.

10. Click OK.

The name of the ControlNet 
adapter updates.

11. Click OK.

12. Skip to Create the OB16_Light 
Indicator on page 200.

6. Right-click the 1784-PCIC(S) 
driver and select Properties.
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1769-L31 controller
(to complete this step on the 1769-L32E or 1769-L35E controllers, see page 194;
to complete this step on the 1769-L32C or 1769-L35CR controllers, see page 196)

IMPORTANT Before you add the Serial driver in the following steps, you must stop and delete the 
Serial driver in RSLinx Classic.

Depending on the messages that display, you might have to take all programming 
and configuration software offline by selecting File > Exit and Shutdown in 
RSLinx Classic.

1. Right-click RSLinx 
Enterprise and select 
Add Driver.

2. Select the Serial DF1 driver 
and click OK.

3. Select the Comm Port on your 
computer to which you connected the 
1756-CP3 cable.

4. In the Devices field, select Logix 
Platform.

5. Check the Use Auto-configuration 
checkbox and click OK.
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7. Click Yes.

8. Select the 
Runtime 
(Target) tab to 
view the path 
from the 
PanelView Plus 
terminal to the 
controller.

9. Click the 
shortcut and 
verify that your 
controller is 
highlighted.

10. Click OK.

6. Click Copy 
from Design 
to Runtime.
Publication IASIMP-QS001C-EN-P - October 2009 199



Chapter 14        Create a PanelView Plus Application
Create the OB16_Light Indicator

All controllers

1. In FactoryTalkView ME, under 
Graphics, right-click Displays 
and select New.

2. Under Objects on the main menu, 
select Indicator > Multistate.

3. Click and drag to 
create the indicator.

4. Right-click and select Properties.
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6. On the States tab, verify that 
State0 is selected.

7. In the Caption, type Light is 
OFF.

8. Select State1.

9. In the Caption, type Light is 
ON.

10. Change the Back Color to yellow.

11. Change the Caption Color to black.

5. On the General tab, 
select 2 for the 
Number of states.
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12. On the Connections tab, click ... 
under Tag.

13. Right click your project and 
select Refresh All Folders.

14. Expand the controller shortcut 
and select Online > Program: 
Main Program.

15. Select ‘xxxx_Light’ (the 
name of your light in ladder 
logic) and click OK.

The Indicator tag is 
populated.

16. Click OK.
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Create a Push Button

All controllers

1. From the Objects menu, select
Push Button > Maintained.

2. Click and drag to create the push 
button beneath the indicator.

3. Right-click the push button you 
just created and select 
Properties.

4. On the States tab, verify that 
State0 is selected.

5. In the Caption, type Push 
to turn light ON.

6. Select State1.

7. In the Caption, type Push to turn 
light OFF.
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8. Select the Connections tab.

9. In the Value row, click ... under 
Tag.

10. Expand your controller shortcut 
and select Online > Program: 
MainProgram.

11. Select PB and click OK.

The Value tag is populated.

12. Click OK.
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Test the Indicator and Push Button

All controllers

5. Click the Play button.

1. Verify that the keyswitch on your 
controller is moved to Run.

2. Right-click an unused area of the 
display and select Display 
Settings.

3. Change the Maximum Tag 
Update Rate to 0.05.

4. Click OK and then click OK 
again.
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7. Click the Stop button.

8. Save your changes.

6. Click the Push Button to toggle the state and turn the light on and off.

You could view the connected logic in the Main Program of the project you created in 
Chapter 10.

When prompted for a title for the 
display, type test_logic.
206 Publication IASIMP-QS001C-EN-P - October 2009



Create a PanelView Plus Application         Chapter 14
Add a Goto Configuration Mode Button

All controllers

1. From the Objects menu, 
choose Advanced > Goto 
Configure Mode.

2. Click and drag to create the 
Goto button next to the push 
button.

3. Right-click the pushbutton and 
select Properties.

4. On the Label tab, enter Goto 
Config for the caption.

5. Click OK.
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Assign Keys

All controllers with PanelView Plus terminals without a touchscreen

If your PanelView Plus does not have a touch screen, you must assign functions keys to the 
display buttons.

If your PanelView Plus has a touchscreen, skip to page 209.

2. Under Select an object, verify that 
MaintainedPushButton is 
selected.

3. Select a function key and click 
Apply.
This example uses F2.

4. Under Select an object, select 
GotoConfigureMode.

5. Select a different function key and 
click Apply.
This example uses F8.

6. Click OK.

7. Add the function key names to the 
button captions (including both 
states of the indicator).

8. Save your changes.

1. Right-click the Push Button and 
select Key Assignments.
208 Publication IASIMP-QS001C-EN-P - October 2009



Create a PanelView Plus Application         Chapter 14
Assign an Initial Screen

All controllers

1. Under System, double-click 
Startup.

2. Check the Initial graphic 
checkbox and select 
test_logic.

3. Click OK.

4. Save your changes.
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Transfer to PanelView Plus Firmware

All controllers
1. Under Application, select 

Create Runtime Application.

2. In Save as type, select the Runtime 
version that matches your 
PanelView Plus firmware.

To check the PanelView Plus 
firmware revision, on the terminal 
select Terminal Setting [F4] > 
System Information > About 
FactoryTalkView ME Station

3. Click Save to accept the default file 
name.

4. From the Tools menu, choose 
Transfer Utility.

5. Click the... button, select the .mer file you just created and click Open.
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6. Verify that the Run application and Replace communications checkboxes are 
checked and verify that your PanelView Plus is selected for the destination terminal.

7. Click Download.

8. Click OK.
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Test the Application on the PanelView Plus Application

All controllers

1. On the PanelView Plus application, 
press Load Application [F1].

2. Select your .mer file and press 
Load [F2].

3. Press Yes [F7].

4. After the application loads, press 
Run Application [F2].

5. Press the Push Button. Verify that the indicator turns on and that the light on the 
Compact digital output module turns on.

6. Press the Push Button again and verify that the indicator and light turn off.
212 Publication IASIMP-QS001C-EN-P - October 2009



Create a PanelView Plus Application         Chapter 14
Additional Resources

Resource Description

FactoryTalkView online help Contains procedures and information for all FactoryTalkView-specific topics.

PanelView Plus Terminal User Manual, 
publication 2711p-UM001

Provides descriptions and procedures for the use of the PanelView Plus terminal.
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Network Worksheet

EtherNet/IP

Enter EtherNet/IP data in the following table. Ethernet addresses (MAC) should be entered by using digits 
1...9 and letters A...F. An example Ethernet address (MAC) is 00:00:BC:21:D7:BE. 

For all EtherNet/IP addresses, the subnet mask is (from page 38):  ______.______.______.______

This quick start uses the example EtherNet/IP subnet mask:      ______.______.______.______

DeviceNet Network

1769-SDN Module Information

RSNetWorx DeviceNet Configuration File Information

Main configuration file name (from page 98):     ______________________________________

Subnet configuration file name and path (from page 122): _________________________________ 

Data For Ethernet Address (MAC) Assigned IP Address Example Assigned 
IP Address

Controller 192.168.1.103

Computer Not needed. 192.168.1.116

POINT I/O adapter 192.168.1.101

PowerFlex40 drive 192.168.1.107

PowerFlex70 drive 192.168.1.109

PanelView Plus 
terminal

Not needed. 192.168.1.105

Series No. (from page 17) Node No. (from page 96) Slot No. (from page 96)

225 255 255

.dnt

.dnt
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        Network Worksheet
ControlNet Network

ControlNet Node Numbers

Device Controller Computer 1734-ACNR 
adapter

PowerFlex 70 
drive

PowerFlex 40 
drive

Node No.
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Rockwell Automation Support

Rockwell Automation provides technical information on the Web to assist you in using its products. At 
http://www.rockwellautomation.com/support/, you can find technical manuals, a knowledge base of FAQs, technical and 
application notes, sample code and links to software service packs, and a MySupport feature that you can customize to make the 
best use of these tools.

For an additional level of technical phone support for installation, configuration, and troubleshooting, we offer TechConnect 
support programs. For more information, contact your local distributor or Rockwell Automation representative, or visit  
http://www.rockwellautomation.com/support/.

Installation Assistance

If you experience an anomoly within the first 24 hours of installation, review the information that is contained in this manual.
You can contact Customer Support for initial help in getting your product up and running.

New Product Satisfaction Return

Rockwell Automation tests all of its products to ensure that they are fully operational when shipped from the manufacturing facility. 
However, if your product is not functioning and needs to be returned, follow these procedures.

Documentation Feedback 

Your comments will help us to serve your documentation needs better. If you have any suggestions on how to improve this 
document, complete this form, publication RA-DU002, available at http://www.rockwellautomation.com/literature/.

United States or Canada 1.440.646.3434

Outside United States or 
Canada

Use the Worldwide Locator at http://www.rockwellautomation.com/support/americas/phone_en.html, 
or contact your local Rockwell Automation representative.

United States Contact your distributor. You must provide a Customer Support case number (call the phone number 
above to obtain one) to your distributor to complete the return process.

Outside United States Please contact your local Rockwell Automation representative for the return procedure.

http://literature.rockwellautomation.com/idc/groups/literature/documents/du/ra-du002_-en-e.pdf
http://www.rockwellautomation.com/support/americas/phone_en.html
http://www.rockwellautomation.com/support/
http://www.rockwellautomation.com/support/
http://www.rockwellautomation.com/literature/
http://www.rockwellautomation.com/locations/
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